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About the Release Notes
The Release Notes are a comprehensive user guide for the latest release of Salesforce. Unlike a traditional release notes document
that includes only a simple list of enhancements and known bugs, the Salesforce Release Notes give you everything you need
to get up and running with the new features and enhancements in the latest release.

What's Included in the Release Notes

For every new major enhancement, the Release Notes provide:

• A brief, high-level description of the functionality
• Implementation tips to help you get started with setup and administration
• Best practice tips to help you maximize the benefit of the functionality
• Complete end-to-end instructions on how to set up and use the functionality

Beyond the major new features, the Additional Enhancements sections include a list and brief description of every other
enhancement or functional change included in the latest release—everything from new merge fields you can use in formulas
to improved icons for greater usability to additional fields that are available in standard reports.

Let the Release Notes be your guide to success with the latest release from salesforce.com!

Summary of Winter '08 Features and Impact on Salesforce Users
Winter '08 includes features that will immediately impact all Salesforce users when the release occurs. You may want to
communicate these changes to the users in your organization before the release so that they are prepared for any changes that
might affect them. Other features require direct action by a Salesforce administrator before your users can benefit from the
new functionality.

The following table summarizes the Winter '08 features and whether they will have an immediate impact on users:

Immediate User ImpactEnabled by
Default?

Feature

None until an administrator enables and configures a
connection.

No. An
administrator must
set up this feature.

Salesforce to Salesforce

None.No.Campaign Sharing

None until an administrator makes the new campaign statistic
fields, Parent Campaign field, and Campaign Hierarchy
related list visible on campaign page layouts.

Yes.Campaign Hierarchies

None.No.Advanced Currency Management Setup

A new Multiple Users tab displays on the assignee lookup
dialog for the New Task page.

Yes.Group Tasks

None. However, administrators see a new page at Setup ➤

Monitoring ➤ Monitor the Case Escalation Queue that
Yes.Case Escalation Rule Queue

allows them to view pending case escalations and cancel them
if necessary.

None. However, administrators see a new page at Setup ➤

Customize ➤ Activities ➤ Activity Settings that replaces
several other activity setup pages.

Yes.Consolidated Activity Settings Page
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Immediate User ImpactEnabled by
Default?

Feature

None.No.Customizing Customer Portal Tabs

None.No.Customer Self-Registration for Your
Customer Portals

None. However, when users merge accounts, they can now
merge accounts that have portal users.

Yes.Merging Accounts with Portal Users

None.No.Send Case Notifications from a System
Address

None until an administrator enables field history tracking on
accounts or contacts and adds the related lists to page layouts.

No.Field History Tracking Available on
Accounts and Contacts

None until an administrator enables manual forecast sharing.No.Manual Sharing Forecasts

None.Yes.Product Search Enhancements

A new Printable View link displays on most list views.Yes.Printable List Views

Campaign reporting enhancements display to users who run
campaign reports.

Yes.Campaign Reporting Enhancements

No matter how far users scroll down tabular report results,
they will see report column headings, unless they are in

Yes.Floating Report Headers

accessibility mode or administrators disable the feature by
clicking Setup ➤ Customize ➤ User Interface, and
deselecting the Enable Floating Report Headers
checkbox.

None until users with the "Mange Custom Report Types"
permission create custom report types that include the reports
and dashboards objects.

Yes.Reporting on Reports and Dashboards

None until users with the "Manage Custom Report Types"
permission clone custom report types.

Yes.Cloning Custom Report Types

None until users choose to run the new standard reports.Yes.New Standard Reports

None.No.Contact Sharing Available for
Organizations with Territory
Management

None.Yes.Visualforce

None until an administrator enables inline editing.No. An
administrator must
set up this feature.

Inline Editing

None until an administrator enables tagging.No. An
administrator must
set up this feature.

Tagging

None.No. Contact
salesforce.com to
enable this feature.

Mobile Administration Console
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Immediate User ImpactEnabled by
Default?

Feature

None until users download the newest version of the Salesforce
Mobile client application from
http://mobile.salesforce.com/setup.

Yes.Salesforce Mobile for BlackBerry:
Related Items Search

Users with assigned mobile licenses can immediately install
and activate Salesforce Mobile on a mobile device without any

Yes.Zero-Admin Mobile Deployment

administrator assistance. To prevent users from activating
Salesforce before you are ready to deploy mobile in your
organization, remove the mobile license from your user
accounts by editing the user records and deselecting the
Mobile User checkbox. For more information about mobile
licenses, see "User Fields" in the Salesforce online help.

None.No.Apex

None.No.Apex Email Service

None.Yes.Force.com Web Services API 11.0

None.Yes.Search Settings Page

The standard Manager field appears as an option for approval
process routing. If a custom Manager field is already

Yes.User Records: New Standard Manager
Field

implemented, both the standard and custom field appear as
options for approval process routing.

Users with the "View Setup and Configuration" immediately
have read-only access to workflow rule and approval process
configurations.

Yes.Workflow Rules and Approval Processes
Visible with "View Setup and
Configuration" Permission

Workflow rules are triggered when users select multiple cases
from a list view and click Close, Change Owner, or Change
Status.

Yes.Workflow Rules for Mass Actions on
Cases

The email signature is no longer included unless the email is
sent from a trial organization or Developer Edition.

Yes.Email Signature from Salesforce.com
Removed
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SALESFORCE APPLICATIONS

Salesforce to Salesforce
Available in: Group, Professional, Enterprise, and Unlimited Editions

Salesforce to Salesforce enables business collaboration both within and across Salesforce organizations. This allows you to
share lead, opportunity, or custom object data with your business partners that use Salesforce and get real-time updates on the
shared data. For example, you can share lead and opportunity data with business partners and manage your entire pipeline
and programs within Salesforce.

Note: Salesforce to Salesforce is only available upon request. To enable Salesforce to Salesforce, contact your
salesforce.com representative.

Salesforce to Salesforce allows you and your business partners to collaborate more easily and effectively.

It allows your business partners to:

• Access all their programs from one place
• Easily integrate your data with the data they manage in Salesforce
• Integrate their business processes with updates received from you using workflow, assignment rules, and reports

It allows you to:

• Have 100% visibility into your partner activity
• Manage your entire pipeline, both internal sales and channel sales, in one place
• Rapidly and easily share data across multitiered partnerships
• Integrate your business processes with updates received from your partners using workflow and assignment rules

Implementation Tips

Before making connections with other organizations using Salesforce to Salesforce, you must complete the following:

• Enabling Salesforce to Salesforce
• Configuring Salesforce to Salesforce

Once you have configured Salesforce to Salesforce, you can make connections with other organizations using Salesforce to
Salesforce. To invite other companies make a connction with you using Salesforce to Salesforce, see Sending an Invitation to
Connect with your Business Partners using Salesforce to Salesforce. If you have received an invitation to make a connection
using Salesforce to Salesforce, see Accepting or Rejecting an Invitation to Join Salesforce to Salesforce. You can manage your
connections using the Connections Home Page.

After you have made a connection to another company using Salesforce to Salesforce, you can share records with that connection.
See Making Records Available to a Connection and Accepting or Rejecting Records Shared from a Connection.
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About Salesforce to Salesforce

Enabling Salesforce to Salesforce

User Permissions Needed

"Modify All Data"To enable Salesforce to Salesforce:

Salesforce to Salesforce is not enabled by Salesforce. To request Salesforce to Salesforce for your organization, contact
salesforce.com.

Caution:  Once you have enabled Salesforce to Salesforce, you cannot disable it. By enabling Salesforce to Salesforce,
you agree to allow salesforce.com to process updates to information in your organization that has been shared with
other organizations.

To enable Salesforce to Salesforce:

1. Click Setup ➤ Customize ➤ Salesforce to Salesforce ➤ Enable.
2. Click Edit.
3. Select Enable.
4. Click Save.

Upon enabling Salesforce to Salesforce, a new user named "Connection User" is created. This user does not count towards
the number of used licenses for your organization, and is not included in any user management view. When your business
partner updates a shared field, the update in your organization is done by this user, allowing you to easily track all changes
made by your business partners.

After Salesforce to Salesforce is enabled:

1. Edit each profile assigned to users who will be working with Salesforce to Salesforce connections. Enable the "Manage
Connections" permission and set the Connection tab visibility to Default On.

All profiles with the "Modify All Data" permission automatically have the "Manage Connections" permission enabled.

2. Configure Salesforce to Salesforce settings, such as communication templates for sending invitations to your business
partners.

3. Add the External Sharing related list to page layouts for the appropriate profiles. For more information, see "Sharing
Records Using Salesforce to Salesforce" in the Salesforce online help.

Note: This related list can be made available to all users, not just users with the "Manage Connections" permission.
A user cannot stop sharing a record unless the user has "edit" permissions on the record.

4. "Create and manage connections with your business partners." in the Salesforce online help

Configuring Salesforce to Salesforce

User Permissions Needed

"Modify All Data"To configure Salesforce to Salesforce:
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You can configure Salesforce to Salesforce to use communication templates for interacting with your business partners. In
addition, you can configure the email address and name used when these communication templates are used. To configure
any of these settings:

1. Click Setup ➤ Customize ➤ Salesforce to Salesforce ➤ Settings.
2. Click Edit and modify the following settings:

DescriptionSetting

The email address from which all Salesforce to Salesforce communication
templates are sent, for example, "partner@acme.com." Salesforce sends the

From Email Address

emails automatically, but they appear to your contacts as if they were sent from
this email address. If a contact responds to a communication template, the
response is sent to this address.

The name that will be associated with the "From" Email Address, for example,
"Acme Channel Manager".

From Email Name

Used to send invitations.Invitation Template

Used to notify a business partner that you have deactivated the connection.Deactivation Template

Used to notify a business partner that you have accepted an invitation.Accept Invitation Template

Used to notify a business partner that you have not accepted an invitation.Reject Invitation Template

Used to notify business partners of changes to an active connection profile.Update Connection Profile
Template

3. Click Save.

Sending an Invitation to Connect with your Business Partners using Salesforce to
Salesforce

User Permissions Needed

"Manage Connections"To send an invitation to a business partner to connect using
Salesforce to Salesforce:

Before you can start sharing data with your business partners, you need to set up a connection to them via Salesforce to
Salesforce. To create that connection, you need to invite your business partner.

Note:  Before beginning the invitation process, you need to create an account and an associated contact for your
business partner.

To send an invitation to a business partner to connect using Salesforce to Salesforce:

1. Click the Connections tab.
2. Click New.
3. Enter a contact name or use the  icon to select a contact.

Caution:  Make sure that the contact's email address is valid; otherwise, your invitation may be sent to the wrong
person.
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4. Optionally, select a related account.

Note: The account associated with the connection can be changed after the invitation is sent.

5. Choose a user to manage the connection.
6. Click Save & Send Invite.

The person you invite will receive an email invitation to connect with you using Salesforce to Salesforce. They can choose to
accept or decline your invitation. You can check whether they have accepted or declined the invitation by reviewing your
connections on the Connections tab. If you choose, you can also resend or cancel the invitation. For more information on
connections, including information on activating an accepted connection, see "Connections Home Page" in the Salesforce
online help.

Accepting or Rejecting an Invitation to Join Salesforce to Salesforce

User Permissions Needed

"Manage Connections"To accept or reject an invitation to connection using Salesforce
to Salesforce:

If a business partner has sent you an invitation to connect using Salesforce to Salesforce, you can accept or reject that invitation
by following these steps:

1. Enable Salesforce to Salesforce for your organization, if it is not already enabled.
2. Click the link in the invitation email to go to the Salesforce login page.
3. Log in as a user with the "Manage Connections" permission.
4. Review the details of the invitation.
5. Click Accept to accept the invitation, or Decline to decline the invitation.

If you aren't sure whether you want to accept or decline, click Decide Later. The invitation displays on the Connections
tab with a connection status of Invitation Received. From the Connections tab you can easily accept or decline the invitation
at a later date.

When you accept or reject an invitation, the company that invited you receives an email notifying them of your decision. The
content of that email can be configured by changing the appropriate email template. For more information, see "Configuring
Salesforce to Salesforce" in the Salesforce online help.

Connections Home Page

User Permissions Needed

"Manage Connections"To manage connections for Salesforce to Salesforce:

The Connections home page allows you to manage your Salesforce to Salesforce connections. These connections include
everyone that you have invited, whether they have accepted, declined, or have not yet responded, as well as all the invitations
you have received.

Clicking on the Connections tab displays a list of recent connections. To view additional connections, select a list view from
the View drop-down list, or click Create New View to define your own custom view. For more information on list views, see
"Creating Custom List Views" in the Salesforce online help.
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Note: You must have the "Manage Connections" permission to create these list views. If you do not create custom
list views, only users with the "Manage Connections" permission will be able to view objects shared from a connection.

To send an invitation to create a new connection, click New, then enter the connection details and click Save & Send Invite.
For more information, see "Sending an Invitation to Connect with your Business Partners using Salesforce to Salesforce" in
the Salesforce online help.

To view details about a connection, click the connection name. The connection details include information on the status of
the connection, the owner of the connection, information about the company, object sharing information, and a connection
history.

You can easily view your accounts and connection relationships by creating custom account reports. For more details on
reporting and Salesforce to Salesforce, see "Tips for Using Salesforce to Salesforce" in the Salesforce online help.

Sharing Records Using Salesforce to Salesforce

Once you have created a connection to another organization, to work with that organization, you can share leads, opportunities,
and custom object data with them. Your business partners do not have direct access to your lead, opportunity, or custom object
record; they have a record in their organization that is connected, via Salesforce to Salesforce, to your record. Any updates to
the shared information on either record is reflected on the other record.

Note:  Making records available to business partners is not the same as sharing records within your organization. For
information on sharing records within your organization, see "Granting Access to Records" in the Salesforce online
help.

You can control the type of records you share with your business partners by selecting which objects and fields to publish. For
more information on publishing objects and fields, see "Publishing Objects in Salesforce to Salesforce" in the Salesforce online
help and "Publishing Fields in Salesforce to Salesforce" in the Salesforce online help.

You can control how the information your business partner makes available to you is used in your organization by subscribing
to objects and mapping the fields on those objects to fields on your own objects. For more information on subscribing to
objects, see "Subscribing to Objects in Salesforce to Salesforce" in the Salesforce online help. For more information on mapping
fields, see "Subscribing to Fields in Salesforce to Salesforce" in the Salesforce online help.

Individual records are made available to your connections by forwarding the record to one or more connections, or by assigning
the record to a queue that contains connections. When you forward a record to a connection, you can send your connection
contact an email notification that a record has been made available. For more information, see "Making Records Available to
a Connection" in the Salesforce online help.

Similarly, your business partners can make records available to you. When a record has been made available to you by a business
partner, you can view basic details about the record from a view on the object's home page. Then you choose whether to accept
the record or not. For more information, see "Accepting or Rejecting Records Shared from a Connection" in the Salesforce
online help.

Once you have accepted a record, you can make it available to other connections in the same way you can make any record
available via Salesforce to Salesforce. This allows you to work in a multitiered business network. In a multi-tiered network,
changes made to the shared record in any organization updates the information in all the organizations that are sharing the
record.

You can easily view the relationship between your connections and your lead, opportunity, or custom objects by creating custom
reports. For more details on reporting and Salesforce to Salesforce, see "Tips for Using Salesforce to Salesforce" in the Salesforce
online help.
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Making Records Available to a Connection

User Permissions Needed

"Read" and "Edit" on the recordTo assign records to a connection:

"Read" and "Edit" on the recordTo stop sharing a record:

Salesforce to Salesforce allows you to assign lead, opportunity, and custom object records, to business partners with whom you
have connections. There are two ways to assign a record to a connection - forward the record to one or more connections or
assign the record to a queue of connections. For more information about queues, see "Managing Queues" in the Salesforce
online help.

To forward a record to a connection:

1. Select the record's detail page.
2. In the External Sharing related list, click the forward button. For example, on an opportunity, click Forward this

Opportunity.
3. Specify the connections that you want to forward the record to.
4. Optionally, select Send Notification Email to send an email notifying the connection's representative that you are forwarding

the record to them.
5. Click Save.

If you make the record available to more than one connection, the first connection to accept the record will have access to it.
After a record has been accepted, you can no longer make it available to another organization.

If you can edit a record, you can stop sharing it with a connection.

1. Select the record's detail page.
2. In the External Sharing related list, click Stop Sharing.

When you stop sharing the record with a connection, the shared record is not deleted from the other organization. Rather,
changes to the record in your organization are not reflected on the record in the connection's organization. Once you have
stopped sharing a record with a connection, you can once more make that record available to your connections.

Accepting or Rejecting Records Shared from a Connection

User Permissions Needed

"Read" and "Edit" on the objectTo accept or reject records:

Salesforce to Salesforce allows you to accept or reject leads, opportunities, and custom objects, that have been made available
to you by business partners with whom you have connections. When accepting a record, you can assign it to yourself, another
user, a queue, or, if it is a lead, use your organization's assignment rules to automatically assign it. If an object is on the detail
side of a master-detail relationship, you can assign the master object when accepting it.

To accept records that have been made available to you:

1. Go to the object's home page.
2. On the object home page, select a connections list view. For example, on the leads home page, in the Leads from

Connections section, select a list view and click Go!.
3. Select the desired records and click Accept to accept the record and assign it to yourself. If the object is on the detail side

of a master-detail relationship, click Accept and Assign Master.
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When you accept an opportunity, you have the option to create a new account or opportunity, or to use an existing account
or opportunity. If you create a new opportunity or account, you can also set the owner of that record.

• To create a new account associated with the opportunity, enter the account name. You must have the "Create" permission
on accounts.

• To associate an exiting account with the opportunity, click the  icon to select an existing account.
• To accept the opportunity without associating it with an account, select Use None.
• To create a new opportunity from the shared record, select Create New Opportunity. You must have the "Create"

permission on new accounts.
• To modify an existing opportunity by connecting it to your business partner's record, click the  icon to select an existing

opportunity.
• If you have more than one record type for an account or opportunity, select the appropriate record type.
• Use the  icon to select an owner for any new records.
• Select Send Notification Email checkbox to send the record owner of the records notification of your changes.

To accept records that have been made available to your company and reassign them to someone else:

1. Go to the object's home page.
2. On the object home page, select a connections list view. For example, on the leads home page, in the Leads from

Connections section, select a list view and click Go!.
3. Select the desired records and click Accept & Change Owner.
4. Select one of the following options to assign the record:

DescriptionOption

Assigns the record to the user or queue you specify.
Optionally, select Send Notification Email to send
an email to the new record owner.

Assigned To

Automatically assigns leads using your organization's
assignment rule. This option is only available for leads.

Assign using active assignment rule

5. Click Save.

Note: You may not be able to save a record from a connection if your organization uses validation rules and the record
does not pass the validation, or if the record was made available to multiple organizations in Salesforce to Salesforce,
and another organization has already accepted it. If a record cannot be saved due to validation rules, it remains in the
list view. If another organization has already accepted the record, it is removed from the list view.

After accepting a shared record, if you update a field that your business partner has subscribed to, the field is automatically
updated on the record in your business partner's organization. Likewise, if your business partner updates a field to which you
have subscribed, it is automatically updated in your organization. When your business partner updates the record, the Last
Updated By field will be set to "Connection User".

Once you have accepted a record, you can make it available to other connections in the same way you can make any record
available via Salesforce to Salesforce. This allows you to work in a multitiered business network. In a multi-tiered network,
changes made to the shared record in any organization updates the information in all the organizations that are sharing the
record.
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Campaign Sharing
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Campaign sharing is now available with Winter '08, empowering you to control campaign access at a more granular level than
ever before. You can now limit campaign access between roles or groups while still allowing individual users to see their
necessary campaigns.

Campaign sharing includes:

• An organization-wide sharing default for campaigns
• Campaign sharing rules
• Manually sharing of campaigns for end users

Implementation Tips

• Initially, the organization-wide default setting for campaigns is Full Access, which is the same as your existing visibility.
Full Access allows all users to view all campaigns, while only users with Marketing User checked in their personal
information can create, edit, delete, or transfer campaigns.

• As of Winter 08, users only need to have read access on the contact or lead to add, edit, or delete campaign history. Prior
to Winter 08, there was inconsistency in the type of access necessary to edit and delete campaign history.

• With Full Access selected as the organization-wide default, users designated as a Marketing User can delete or transfer
any campaign regardless of whether they are the campaign’s owner. Changing the organization-wide default to something
other than Full Access restricts the ability to delete or transfer a campaign to the campaign’s owner and managers above
him or her in the role hierarchy. Any manager above the campaign owner in the role hierarchy must also be designated as
a Marketing User to delete or transfer campaigns.

• A user must be designated as a Marketing User to create, update, delete, transfer, or share campaigns.
• A user must be a Marketing User and have the "Edit" permission on campaigns to use the mass manage campaign member

tools available from the campaign record, reports, or views.

Best Practices

• In Enterprise, Unlimited, and Developer Editions, designate all users as Marketing Users when enabling campaign sharing.
This simplifies administration and troubleshooting because access can be controlled using sharing and profiles.

Note:  Professional Edition customers cannot manage users this way because custom profiles are not enabled in
Professional Edition organizations.

• To segment visibility between business units while maintaining existing behavior within a business unit:

1. Set the campaign organization-wide default to Private.
2. Create a sharing rule to grant marketing users Full Access to all campaigns owned by users within their business unit.
3. Create a sharing rule to grant all non-marketing users in a business unit Read Only access to all campaigns owned by

users in their business unit.

• When a single user, such as a regional marketing manager, owns multiple campaigns and needs to segment visibility
between business units, share campaigns individually instead of using sharing rules. Sharing rules apply to all campaigns
owned by a user and do not allow segmenting visibility.

• Create all campaign sharing rules prior to changing your organization-wide default to reduce the affect the change has on
your users.
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• To share all campaigns in your organization with a group of users or a specific role, create a sharing rule that applies to
campaigns owned by members of the "Entire Organization" public group.

• Minimize the number of sharing rules you need to create by using the "Roles and Subordinates" option instead of choosing
a specific role.

About Campaign Sharing

Setting the Campaign Sharing Model

To maintain your organization’s sharing model and specify sharing rules, click Setup ➤ Security Controls ➤ Sharing Settings.
This page now includes organization-wide sharing defaults for campaigns as well as campaign sharing rules. Click Edit in the
Organization Wide Defaults section to modify the default sharing for campaigns.

DescriptionAccess Setting

Users can view, update, delete, transfer, or share records they
own or where they are the manager of the owner going up the
role hierarchy.

Private

Users can view all records.Public Ready Only

Users can view and update all records.Public Read/Write

Users can view, update, delete, or transfer all records.Full Access

Setting Campaign Sharing Rules

Sharing rules allow you to selectively grant data access to defined sets of users. You can create campaign sharing rules based
on who owns the campaign, and set default sharing access for campaigns.

1. If you plan to share data with public groups, confirm that the appropriate public groups have been created. To create your
groups, see "Managing Groups" in the Salesforce online help.

2. Click Setup ➤ Security Controls ➤ Sharing Settings.
3. Click New in the campaign sharing rules related list. A page displays with sharing rule fields.
4. In the first line, select the source data set to be shared based on who owns the record. You can choose users who belong

to public groups, roles, or roles and subordinates.

a. In the first drop-down list, choose a data set category. The available categories include:

DescriptionCategory

All public groups defined by your administrator.Public Groups

All roles defined for your organization. This includes all
of the users in the specified role.

Roles

All roles defined by your organization including all of the
users in the specified role plus all of the users in roles below
that role in the role hierarchy.

Roles and Subordinates

b. In the second drop-down list, choose a specific data set.
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5. In the Share with line, select the set of users who should have access to that data.

a. In the first drop-down list, choose a category. The available categories include:

DescriptionCategory

All public groups defined by your administrator.Public Groups

All roles defined for your organization. This includes all
of the users in the specified role.

Roles

All roles defined by your organization including all of the
users in the specified role plus all of the users in roles below
that role in the role hierarchy.

Roles and Subordinates

b. In the second drop-down list, choose a specific set of users.

6. In the Campaign Access drop-down list, select the sharing access that the users should have to campaigns. The available
settings include:

DescriptionAccess Setting

Users can view, but not update, records.Ready Only

Users can view and update records.Read/Write

Users can view, update, delete, transfer or share records.Full Access

7. Click Save.

Notes on Sharing Rules

• You can use sharing rules to grant wider access to data. You cannot restrict access below your organization-wide default
levels.

• Sharing rules apply to all new and existing records that meet the definition of the source data set.
• Sharing rules apply to both active and inactive users.
• When you change the access levels for a sharing rule, all existing records are automatically updated to reflect the new access

levels.
• When you delete a sharing rule, the sharing access created by that rule is automatically removed.
• When you transfer records from one user to another, the sharing rules are reevaluated to add or remove access to the

transferred records as necessary.
• When you modify which users are in a group, role, or territory, the sharing rules are reevaluated to add or remove access

as necessary.
• Sharing rules automatically grant additional access to related records.
• Managers in the role hierarchy are automatically granted the same access that users below them in the hierarchy have from

a sharing rule.
• Making changes to sharing rules may require changing a large number of records at once.
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Sharing Campaigns

User Permissions Needed

"Read" on campaignsTo view campaigns:

"Read" on campaigns

AND

Marketing User checked in your user information

To share campaigns:

Your administrator defines your organization's sharing model for campaign access. However, you can extend sharing privileges
for your own campaigns individually. Use campaign sharing to increase access to your campaigns; you cannot restrict access
beyond your organization’s default access levels.

To extend the sharing of a campaign, click Sharing on the campaign you want to share.To grant access to others, see "Granting
Access to Records" in the Salesforce online help. To view all users that have access to the record, see "Viewing Which Users
Have Access" in the Salesforce online help.

Special Considerations

• To share a campaign, you must have Full Access to the campaign and have the Marketing User checkbox selected in
your personal information.

• The Sharing button is available depending on your organization-wide default for campaigns.
• Make sure you are sharing records with users who have the appropriate "Read" permission on their profiles for viewing

the shared records. See "Standard Object Permissions" in the Salesforce online help.
• Sharing a campaign does not automatically grant read access to all the campaign members. Make sure that the user you

are sharing a campaign with has visibility to the associated leads or contacts.
• The campaign hierarchy statistic fields provide aggregate data for a parent campaign and all the campaigns below it in the

hierarchy, regardless of whether a user has sharing rights to a particular campaign within the hierarchy. Therefore, consider
your organization's campaign sharing settings when enabling campaign hierarchy statistics. If you do not want users to see
aggregate hierarchy data, remove any or all of the campaign hierarchy statistic fields from the Campaign Hierarchy related
list. These fields will still be available for reporting purposes. For more information, see "Viewing Campaign Hierarchy
Statistics" in the Salesforce online help.

Campaign Hierarchies
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

Campaign hierarchies provide a powerful categorization tool that enables you to analyze and report on the health of your
related campaigns. By associating campaigns with one another via a lookup relationship, you can group campaigns within a
specific marketing program or initiative. A hierarchy can contain up to five levels, and each level can have an unlimited number
of individual campaigns.

Implementation Tips

• All campaigns in a hierarchy must use the same currency. If opportunities associated with the campaigns use different
currencies, the opportunity value fields will be converted to the user's currency .
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• Eight new summary statistic fields are included in the Campaign Hierarchy related list to summarize the totals from all
campaigns in a hierarchy: Total Responses in HierarchyTotal Leads in Hierarchy, Total Converted
Leads in Hierarchy, Total Contacts in Hierarchy, Total Opportunities in Hierarchy, Total Value
Opportunities in Hierarchy, Total Won Opportunities in Hierarchy, and Total Value Won
Opportunities in Hierarchy. In Enterprise, Unlimited, and Developer Editions, use field-level security to make
these new fields visible to users. In Professional Edition, add these fields to the related list by customizing the campaign
page layout. If you prefer, you can also add these fields to the campaign page layout in a new section; the fields will appear
in the new section and in the Campaign Hierarchy related list. In the related list, values for the new fields appear in the
Hierarchy Total row.

• Calculating campaign hierarchy statistics may take a few minutes depending on the number of records affected and other
factors.

• Campaign hierarchy statistics do not support validation or workflow rules.

Best Practices

• The campaign hierarchy statistics fields provide aggregate data for a parent campaign and all the campaigns below it in
the hierarchy, regardless of whether a user has sharing rights to a particular campaign within the hierarchy. Therefore,
consider your organization's campaign sharing settings when enabling campaign hierarchy statistics. If you do not want
users to see aggregate hierarchy data that includes campaigns to which the users do not have access, you can choose to omit
any or all of the campaign hierarchy statistics fields from the Campaign Hierarchy related list or page layout. If you do not
add the campaign hierarchy statistic fields to the campaign detail, you can still access these fields on reports.

• Create a classification scheme for your hierarchies that includes a unique name for each hierarchy level. For example, your
organization might use "tactic," "program," "initiative," and "region" levels in a hierarchy. Add a custom picklist with these
values to your campaign layouts so users can associate campaigns to hierarchy levels. The custom picklist enables you to
run comprehensive reports that contain aggregate statistics for any hierarchy level across all of your campaigns.

• Use the Campaign Detail custom report and the Campaign ROI Analysis report to analyze campaign hierarchies. Both
reports contain Campaign Hierarchy Statistics fields that provide aggregate values for a parent campaign and all the
campaigns below it in the hierarchy. Sorting the reports by the hierarchy custom picklist will enable you to gauge the overall
status of your marketing efforts at any hierarchy level.

• When running Campaign Detail or Campaign ROI Analysis reports, keep in mind that the Campaign Hierarchy Statistics
fields provide a roll-up of campaign hierarchy data but the Campaign Planning and Statistics fields represent individual
campaigns.

About Campaign Hierarchies

Creating a Campaign Hierarchy

After adding the Parent Campaign field to your page layout, repeat the following procedure for each campaign in a hierarchy:

1. On the campaign where you want to add a parent, click Edit.
2. Click the lookup icon next to the Parent Campaign field.
3. Search for a campaign or click New to create a new parent campaign. Searching for a campaign returns both active and

inactive campaigns in the search results.

Note:  Search results only include campaigns for which you have sharing access.

4. If you are creating a new campaign as the parent, provide the campaign details.
5. Click Save on the detail page.
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Viewing a Campaign Hierarchy

To view the hierarchy for a campaign, click View Hierarchy next to the Campaign Name field on the campaign detail page.
If a campaign is not part of a hierarchy, its corresponding Campaign Hierarchy page shows only the campaign you selected.

On the Campaign Hierarchy page, campaigns are indented to show that they are related to the campaigns above them.
Campaigns are listed in descending order based on their hierarchy level. Click any campaign name to open the detail page for
that campaign. If you do not have sharing rights for a campaign in the hierarchy, you see the campaign name on the Campaign
Hierarchy page but the corresponding fields are empty.

Statistics for an individual campaign are in the Campaign Statistics section of the campaign detail page. Aggregate statistics
for parent and child campaigns are in the Campaign Hierarchy related list.

Viewing Campaign Hierarchy Statistics

Campaign detail pages include a Campaign Hierarchy related list, which displays a parent campaign and all the campaigns
directly below it in the campaign hierarchy.

The following fields provide summary statistics for each campaign in the list as well as the total value for the parent campaign
and all the campaigns below it in the hierarchy:

Note:  For Enterprise, Unlimited, and Developer Editions, these fields only appear in the Campaign Hierarchy related
list if they are enabled via field-level security. For Professional Edition, these fields only appear in the Campaign
Hierarchy related list if they are added to the campaign page layout.The values for these fields appear in the Hierarchy
Total section of the Campaign Hierarchy related list.

• Total Leads in Hierarchy

• Total Converted Leads in Hierarchy

• Total Contacts in Hierarchy

• Total Opportunities in Hierarchy

• Total Won Opportunities in Hierarchy

• Total Value Won Opportunities in Hierarchy

• Total Value Opportunities in Hierarchy

• Total Responses in Hierarchy

The Campaign Hierarchy related list shows a maximum of two hierarchy levels: the parent campaign and its child campaigns.
If a child campaign has children, those children do not appear in the related list but their data is included in the field values.
The campaign hierarchy statistics fields provide aggregate data regardless of whether you have sharing rights to view individual
campaigns within the hierarchy. However, if you do not have access to a campaign that appears in the related list, you cannot
view its detail page from the link on the related list. To view all the levels in a campaign hierarchy, click the View Hierarchy
link next to the Campaign Name on the campaign detail page.

Additional Salesforce Application Enhancements

Advanced Currency Management Setup

You can now enable advanced currency management without contacting salesforce.com.

To enable advanced currency management:

1. Enable multiple currencies for your organization. For more information, see "Managing Multiple Currencies" in the
Salesforce online help.

2. Click Setup ➤ Company Profile ➤ Manage Currencies.
3. Click Enable.
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4. When prompted, select Yes, I want to enable Advanced Currency Management and click Enable.

For more information on advanced currency management, see "About Advanced Currency Management" in the Salesforce
online help.

Group Tasks

You can create a task so that up to 100 users are each assigned an independent copy of the task. For example, you could create
a task "Submit your expense reports" with the appropriate due date and assign it to a team of account executives. To build a
list of users you want to assign to a newly-created task, open the assignee lookup on the New Task page and click the Multiple
Users tab in the lookup dialog. Note that these copies are independent and not linked; they can be edited, transferred, or
deleted individually. For more information, see "Creating Group Tasks" in the Salesforce online help.

Case Escalation Rule Queue

Now, when Salesforce triggers a case escalation rule that has time-dependent actions, users with the "Modify All Data"
permission can view pending case escalations and cancel them if necessary.

To view pending actions:

1. Click Setup ➤ Monitoring ➤ Monitor the Case Escalation Queue.
2. Click Search to view all pending actions for any active case escalation rule, or set the filter criteria and click Search to view

only the pending actions that match the criteria.

To cancel pending actions:

1. Select the box next to the pending actions you want to cancel. Optionally, check the box in the column header to select all
currently displayed items.

2. Click Delete. Salesforce cancels the pending action.

Consolidated Activity Settings Page

Several organization-wide activity settings such as enabling activity reminders, enabling recurring events, and enabling email
tracking have been consolidated on a single page at Setup ➤ Customize ➤ Activities ➤ Activity Settings. Previously, these
settings were separated on different setup pages. For more information, see "Customizing Activity Settings" in the Salesforce
online help.

Customer Portal Enhancements

Customizing Customer Portal Tabs
Now, you can choose which tabs display to all users logged in to a Salesforce Customer Portal, as well as
customize the order in which tabs display to portal users. To customize the tabs for a Customer Portal,
click Setup ➤ Customize ➤ Customer Portal ➤ Settings, select the name of the Customer Portal, and
click Customize Portal Tabs.

Customer Self-Registration for Your Customer Portals
Now, your customers can register themselves for your Customer Portal.To enable this feature, click Setup
➤ Customize ➤ Customer Portal ➤ Settings and select the Enable Self-Registration checkbox.

When you select this checkbox and add the Allow Customer Portal Self-Registration checkbox
to contact page layouts, contacts whose records are marked Allow Customer Portal
Self-Registration can view a self-registration area on the Login page of your Customer Portal. From
the self-registration area, users can enter their email address and click Submit to receive an automatically
assigned username and password for logging in to your Customer Portal. Other email notifications sent
to users regarding their registration status include:

• Existing user, from which the user can enter another email address or click a Forgot Password? link
to retrieve his or her password.
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• New user, which informs the user that the email address he or she submitted does not match an existing
contact in your organization. If an administrator has implemented Web-to-Case or Web-to-Lead to
capture new user information, then the user can click a link to enter his or her information on the
appropriate form.

• Internal error, which informs the user that an error occurred during the self-registration process and
that your portal's administrator has been notified about the error.

• Ineligible user, which informs the user that he or she is not eligible for self-registration to your Customer
Portal. This notification is sent when a submitted email address matches a contact that does not have
the Allow Customer Portal Self-Registration checkbox selected. It is also sent when a
submitted email address does not match any contacts, and your administrator has not set up
Web-to-Lead or Web-to-Case to capture new user information.

Additionally, for users who self-register for your Customer Portal but lack an existing contact record, you
can specify the URL of a Web-to-Lead or Web-to-Case form so that their information can be captured
and converted to a contact. Furthermore, you can select the default role, profile, and user license for users
who self-register for your Customer Portal. For more information on Web-to-Lead, Web-to-Case, roles,
profiles, and user licenses, see the Salesforce online help.

Merging Accounts with Portal Users
Now, you can merge accounts that have contacts associated with the same type of portal. For example,
you can merge accounts that have contacts associated with a PRM portal or Customer Portal, but you
cannot merge an account that has contacts associated with a PRM portal with an account that has contacts
associated with a Customer Portal. Note that when you merge accounts that have contacts associated with
multiple portals that a contact's access to a specific portal does not change. This is because a portal user's
profile determines the portal he or she can access.

To merge accounts, simply click the Merge link on the Tools section of the Accounts tab. To ensure that
merged accounts will include contacts associated with a portal, select the account with portal users as the
master record during the merge process.

Send Case Notifications from a System Address
Now, you can prevent Self-Service or Customer Portal users who update their cases from receiving any
"out-of-office" emails from case owners whose email is set to "out-of-office". By clicking Setup ➤

Customize ➤ Cases ➤ Support Settings and selecting Send Case Notifications from System
Address, you can specify that case comment, attachment, and assignment notifications sent to case
owners are sent from a system address, rather than the address of the user who updated the case. System
notifications display a "From" email address of "noreply@salesforce.com", and an email "Name" related
to the message, such as "Case Comment Notification".

Field History Tracking Available on Accounts and Contacts

Field history tracking has been extended to include accounts, person accounts, and contacts. This new functionality provides
the ability to track and audit changes to standard and custom account, person account, and contact fields. For more information,
see Tracking Field History.

Manual Sharing Forecasts

Your administrator defines your organization's forecasting hierarchy, which determines which users can view the forecast data.
However, your administrator can manually extend sharing privileges for forecast data, and you may be able to manually extend
sharing privileges for your own forecast data as well. Manual forecast sharing can only increase access to forecast data; it cannot
restrict access for users who already have access. To manually share a forecast, you must be an administrator or a forecast
manager who has been given access to share your forecast data.

For more information on manually sharing forecasts, see "Manually Sharing a Forecast" in the Salesforce online help.
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Product Search Enhancements

The following search features are now available for products :

• Administrators can choose default columns and sort order in product searches by clicking Customize... and selecting
Columns For All Users on the product search page.

• You can select which columns appear in your products search results and change the order of the selected columns by
clicking Customize... and choosing My Columns. Use the Add and Remove arrows to move columns from the Available
Fields list to the Selected Fields list and use the Up and Down arrows to change the order of the columns.

• Administrators can customize the numbers of records to display on product search pages. For more information, see
Customizing Search Settings.

For more information on searching for products and opportunity products, see "Searching for Price Books and Products" in
the Salesforce online help.

Printable List Views

You can now can print list views for most objects. List views that support this capability—including accounts, activities, cases,
custom objects, leads, opportunities, and more—have a Printable View link in the colored title bar (next to the Help for this
Page link). Clicking Printable View opens the contents of the current list view in a simple, print-ready format. For more
information, see "Printing List Views" in the Salesforce online help.

Report Enhancements

Campaign Reporting Enhancements
A new series of campaign reporting enhancements provides marketing users greater visibility into campaign
performance:

• The new Campaigns with Campaign Members report provides information about leads and contacts
on multiple active or inactive campaigns.

• On the Campaigns with Leads and Campaigns with Contacts reports, the Member ID field has been
renamed Lead ID/Contact ID and a new Member ID field has been added. This change enables
users to sort data based on both types of IDs rather than the Member ID only. If users have existing
reports that sort data based on the Member ID field, the field label will be automatically converted to
Lead ID/Contact ID.

• Campaigns with Contacts and Campaigns with Leads reports can now include the contact owner role
or lead owner role.

• Standard opportunity reports can now include the Campaign Source field.
• Campaigns with Leads, Campaigns with Contacts, and Campaigns with Campaign Member reports

can now indicate whether a member has responded to the campaign.

Floating Report Headers
Now, you can keep the column headings on tabular reports in sight no matter how far users scroll down
report results. With floating report headers, users can scroll to the bottom of lengthy tabular reports
without having to scroll back to the top to view the names of the column headings. Users can also click
floating report headers to sort data in a specific column. When users sort data by clicking a floating report
heading, the report refreshes and redirects users to the beginning of report results.. To disable this option
for all users in your organization, click Setup ➤ Customize ➤ User Interface, and deselect the Enable
Floating Report Headers checkbox.

Note that floating report headers do not display for users with accessibility mode enabled. For more
information, see "Accessibility Overview" in the Salesforce online help.

Reporting on Reports and Dashboards
Now, you can create custom report types from which users can report on your organization's reports and
dashboards. When defining a custom report type, select Reports or Dashboards from the Primary
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Object drop-down list on the New Custom Report Type page. For more information, see "Defining
Custom Report Types" in the Salesforce online help.

Cloning Custom Report Types
Now, you can clone custom report types instead of manually duplicating all the objects and fields included
in an existing custom report type that you want to reuse. Click Setup ➤ Build ➤ Report Types to display
the All Custom Report Types page, which shows the list of custom report types defined for your
organization. Select the name of the custom report type you want to clone, and click Clone.

Diagrams of Object Relationships in Custom Report Types
Now, when you choose or view object relationships for a custom report type, diagrams automatically
display to help you better understand the object relationships included in the custom report type as well
as the data displayed in reports run from it.

Territories Available for Custom Report Types
You can now include territories in custom report types. This allows users with the "Manage Custom
Report Types" permission to define report criteria from which users can run and create custom reports,
such as accounts with territories and territories with opportunities.

Reports run from custom report types that include territories may display results differently than standard
reports that include territories. This is because reports run from custom report types only display results
with territories, such as accounts with territories, whereas standard reports that include territories may
display results without territories. For example, if you select the Account Territory Report, results display
accounts without territories. Furthermore, the Territories  filter on report results run from custom
report types that include territories does not include Multiple Territories or Missing Territories.

New Standard Reports
Now, you can access two new standard reports by clicking the Reports tab and selecting the following:

• Account History Report - This report allows you to see the data history for accounts or person
accounts if your organization tracks field history on accounts.

• Contact History Report - This report allows you to see the data history for contacts if your organization
tracks field history on contacts.

Additional Fields Available for Reports
Now, on the Select Columns page of the report wizard, you can add the following fields to reports:

• Case Comment Created By Role - This field allows you to see the role of a user who created a
comment on a case. This field is only available on case reports.

• Edited By Role - This field allows you to see the role of a user who updated a record. This field is
only available on history reports.

Contact Sharing Available for Organizations with Territory Management

Prior to Winter ’08, customers using Territory Management were unable to grant users access to an account without granting
them access to all the contacts. Now in Winter ’08, customers can use the Contact Sharing feature released in Summer ’07
along with Territory Management.

The access settings on a territory now include an option to set the contact access for all accounts associated with that territory.
The contact access setting on the territory does not appear until the sharing organization-wide default for contacts has been
changed from “Controlled by Parent” to a different setting.
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FORCE.COM PLATFORM

Visualforce
Available in: Developer Edition as a developer preview

Over the past several years, salesforce.com has created a comprehensive platform for building on-demand applications. Like
other sophisticated application development platforms, the Force.com platform offers separate tools for defining:

• The structure of the data, that is, the data model
• The rules that detail how that data can be manipulated, that is, the business logic
• The layouts that specify how that data should be displayed, that is, the user interface

While the tools for building the data model and business logic for applications are powerful, robust solutions that run natively
on Force.com platform servers, the existing tools for defining user interfaces have had certain limitations:

• Page layouts, the point-and-click tool that allows application developers to organize fields, buttons, and related lists on
record detail pages, do not provide much flexibility in how sets of information are displayed. Fields must always appear
above related lists, buttons must always appear above fields, and s-controls and custom links can only be placed in particular
areas.

• S-controls, the tool that allows application developers to display custom HTML in a detail page or custom tab, provide
more flexibility than page layouts, but:

• Execute from within a browser, causing poor performance if displaying or updating values from more than a few records
at a time

• Do not provide an easy way to give custom user interface elements the same look-and-feel as standard Salesforce pages
• Require developers to enforce field uniqueness and other metadata dependencies on their own

For these reasons, salesforce.com has now introduced Visualforce, the next-generation solution for building sophisticated
custom user interfaces on the Force.com platform.

About Visualforce

What is Visualforce?

Visualforce is a framework that allows developers to build sophisticated, custom user interfaces that can be hosted natively on
the Force.com platform. The Visualforce framework includes a tag-based markup language, similar to HTML.

In the Visualforce markup language, each Visualforce tag corresponds to a coarse or fine-grained user interface component,
such as a section of a page, a related list, or a field. The behavior of Visualforce components can either be controlled by the
same logic that is used in standard Salesforce pages, or developers can associate their own logic with a controller class written
in Apex.
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Figure 1: Sample Visualforce Components and their Corresponding Tags

What is a Visualforce Page?

Developers can use Visualforce to create a Visualforce page definition. A page definition consists of two primary elements:

• Visualforce markup
• A Visualforce controller

Visualforce Markup

Visualforce markup consists of Visualforce tags, HTML, JavaScript, or any other Web-enabled code embedded within a single
<apex:page> tag. The markup defines the user interface components that should be included on the page, and the way they
should appear.

Visualforce Controllers

A Visualforce controller is a set of instructions that specify what happens when a user interacts with the components specified
in associated Visualforce markup, such as when a user clicks a button or link. Controllers also provide access to the data that
should be displayed in a page, and can modify component behavior.

A developer can either use a standard controller provided by the Force.com platform, or add custom controller logic with a
class written in Apex.:

• A standard controller consists of the same functionality and logic that is used for a standard Salesforce page. For example,
if you use the standard Accounts controller, clicking a Save button in a Visualforce page results in the same behavior as
clicking Save on a standard Account detail page.
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• A custom controller is a class written in Apex that implements all of a page's logic, without leveraging a standard controller.
If you use a custom controller, you can define new navigation elements or behaviors, but you must also reimplement any
functionality that was already provided in a standard controller.

Like other Apex classes, custom controllers execute entirely in system mode, in which the profile-based permissions and
field-level security of the current user are ignored.

• A controller extension is a class written in Apex that adds to or overrides behavior in a standard or custom controller.
Extensions allow you to leverage the functionality of another controller while adding your own custom logic.

Because standard controllers execute in user mode, in which the profile-based permissions, field-level security, and sharing
rules of the current user are enforced, extending a standard controller allows you to build a Visualforce page that respects
user permissions. Although the extension class executes in system mode, the standard controller executes in user mode.

Note:  Although custom controllers and controller extension classes execute in system mode and thereby ignore
profile-based permissions and field-level security, you can choose whether they respect a user's organization-wide
defaults, role hierarchy, and sharing rules by using the with sharing keywords in the class definition. For information,
see "Using the with sharing Keywords" in the Apex Developer's Guide at
www.salesforce.com/us/developer/docs/apexcode/salesforce_apex_language_reference.pdf.

Where Can Visualforce Pages Be Used?

Similar to s-controls, developers can use Visualforce pages to:

• Override standard buttons, such as the New button for accounts, or the Save button for contacts
• Override tab overview pages, such as the Accounts tab home page
• Define custom tabs
• Embed components in detail page layouts, similar to the way inline s-controls can be embedded

Which Editions Support Visualforce?

Visualforce is currently available as a developer preview for Developer Edition users only. To sign up for a Developer Edition
account and the Visualforce developer preview, go to the Apex Developer Network at www.salesforce.com/developer/ and
follow the instructions. A Developer Edition account gives you access to a free Developer Edition organization.

Enabling Development Mode

User Permissions Needed

"Customize Application"To enable development mode:

Although you can view and edit Visualforce page definitions from the setup area by clicking Setup ➤ Build ➤ Pages, enabling
Visualforce developer mode is the best way to build Visualforce pages. Development mode provides you with:

• A special development footer on every Visualforce page that you define

The footer includes an editor for the page markup and, if applicable, the associated controller. The page markup editor
offers highlighting and auto-suggest for component tag names, and the footer also includes a link to the component
reference documentation.

• The ability to define new Visualforce pages just by entering a particular URL
• Error messages that include more detailed stack traces than what standard users receive

To enable Visualforce developer mode:
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1. Click Setup ➤ My Personal Information ➤ Personal Information, and click Edit.
2. Select the Development Mode checkbox.
3. Click Save.

Defining Visualforce Pages

User Permissions Needed

"Customize Application"To create Visualforce pages:

You can create Visualforce pages either by using Visualforce development mode, or by creating pages in Setup.

To create a page using Visualforce developer mode:

1. In your browser, enter a URL in the following form:

http://<mySalesforceInstance>/apex/<nameOfNewPage>

For example, if you want to create a page called "HelloWorld" and your Salesforce organization uses the
na3.salesforce.com instance, enter https://na3.salesforce.com/apex/HelloWorld.

2. Because the page does not yet exist, you are directed to an intermediary page from which you can create your new page.
Click Create page <nameOfNewPage> to create the new page. Both the page Name and Label are assigned the
<nameOfNewPage> value you specified in the URL.

To create pages in Setup:

1. Click Setup ➤ Build ➤ Pages.
2. Click New.
3. In the Name text box, enter the text that should appear in the URL as the page name. This name must only contain

alphanumeric characters, start with a letter, and be unique from all other pages in your organization.
4. In the Label text box, enter the text that should be used to identify the page in Setup tools, such as when defining custom

tabs, or overriding standard buttons.
5. In the Body text box, enter Visualforce markup for the page. A single page can hold up to 1 MB of text, or approximately

1,000,000 characters.
6. Click Save to save your changes and return to the Visualforce detail screen, or click Quick Save to save your changes and

continue editing your page. Your Visualforce markup must be valid before you can save your page.

Note: Though your Visualforce markup can be edited from this part of setup, to see the results of your edits you
have to navigate to the URL of your page. For that reason, most developers prefer to work with development mode
enabled so they can view and edit pages in a single window.

Once your page has been created, you can access it using the following URL:

http://<mySalesforceInstance>/apex/<nameOfNewPage>

Managing Visualforce Pages

User Permissions Needed

"Customize Application"To create and edit Visualforce pages:
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After creating Visualforce pages, you can customize, edit, and delete them. Click Setup ➤ Build ➤ Pages to display the
Pages list page, which shows all the Visualforce pages defined for your organization. From the Pages list page, you can:

• Click New to define a new Visualforce page.
• Click a page name to display detailed information about the page, including its label and Visualforce markup.
• Click Edit next to a page name to modify the page's name, label, or Visualforce markup.
• Click Del to remove a page.

Viewing and Editing Visualforce Pages

User Permissions Needed

"Customize Application"To clone, edit, or delete Visualforce markup:

"Author Apex"To edit custom Visualforce controllers

Click Setup ➤ Build ➤ Pages and click the name of a Visualforce page to view its details, including when it was created,
when it was last modified, and the Visualforce markup associated with the page.

From the detail page, you can do any of the following:

• Click Edit to edit the page markup.
• Click Delete to delete the page.
• Click Clone to create a copy of the page. You must specify a new name for the new page.
• Click Where is this used? to view a list of all references to the page in your organization.

Viewing and Editing Visualforce Pages with Development Mode Enabled

With development mode enabled, you can also view and edit the content of a page by navigating to the URL of the page. For
example, if a page is named HelloWorld, and your salesforce.com instance is na3.salesforce.com, enter
https://na3.salesforce.com/apex/HelloWorld.

The rendered page is displayed with the development mode footer at the bottom of the window:

• Click Page Editor to view and edit the associated Visualforce markup without having to return to the Setup area. All
changes you make to the page markup immediately display when you save the page.

• If the page uses a custom controller, click Controller to edit the associated Apex class.
• Click Save (just above the edit pane) to save your changes and refresh the content of the page.
• Click Component Reference to view the online documentation for all supported Visualforce components.
• Click Where is this used? to view a list of all items in Salesforce that reference the page, such as custom tabs, controllers,

or other pages.

What is a Static Resource?

Static resources allow you to upload content that you can reference in a Visualforce page, including archives (such as .zip and
.jar files), images, stylesheets, JavaScript, and other files.

Using a static resource is preferable to uploading a file to the Documents tab because:

• You can package a collection of related files into a directory hierarchy and upload that hierarchy as a .zip or .jar archive.
• You can reference a static resource in page markup by name using the $Resource global variable instead of hard-coding

document IDs:
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To reference a stand-alone file, use $Resource.<resource_name> as a merge field, where <resource_name> is
the name you specified when you uploaded the resource. For example:

<apex:image url="{!$Resource.TestImage}" width="50" height="50" />

•

• To reference a file in an archive, use the URLFOR function. Specify the static resource name that you provided when
you uploaded the archive with the first parameter, and the path to the desired file within the archive with the second.
For example:

<apex:image url="{!URLFOR($Resource.TestZip, 'images/Bluehills.jpg')}" width="50"
height="50" />

A single static resource can be up to 5 MB in size, and an organization can have up to 250 MB of static resources, total.

Defining Static Resources

User Permissions Needed

"Customize Application"To create static resources:

To create a static resource:

1. Click Setup ➤ Build ➤ Static Resources.
2. Click New Static Resource.
3. In the Name text box, enter the text that should be used to identify the resource in Visualforce markup. This name can

only contain alphanumeric characters, must begin with a letter, and must be unique in your organization.

Note:  If you reference a static resource in Visualforce markup and then change the name of the resource, the
Visualforce markup is updated to reflect that change.

4. In the Description text area, specify an optional description of the resource.
5. Next to the File text box, click Browse to navigate to a local copy of the resource that you want to upload.

A single static resource can be up to 5 MB in size, and an organization can have up to 250 MB of static resources, total.

6. Click Save.

Managing Static Resources

User Permissions Needed

"Customize Application"To create and edit static resources:

After creating static resources, you can customize, edit, and delete them. Click Setup ➤ Build ➤ Static Resources to display
the Static Resources list page, which shows the list of resources defined for your organization. From this page you can:

• Click New Static Resource to define a new static resource.
• Click a resource name to display detailed information about the page, including its MIME type and size.
• Click Edit next to a resource to modify the resource's name or to upload a new version of the resource.
• Click Del to remove a resource.
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Viewing and Editing Static Resources

User Permissions Needed

"Customize Application"To clone, edit, or delete static resources:

Click Setup ➤ Build ➤ Static Resources and click the name of a resource to view its details, including its MIME type, the
size of the resource in bytes, when it was created, and when it was last modified.

From the detail page, you can do any of the following:

• Click Edit to edit the resource.
• Click Delete to delete the resource.
• Click Clone to create a copy of the resource. You must specify a new name for the new resource.

Additional Information

To learn more about Visualforce:

• Review the Visualforce Developer's Guide available at www.salesforce.com/us/developer/docs/pages/index.htm
• Visit the Apex and Visualforce page on the Apex Developer Network at

wiki.apexdevnet.com/index.php/Apex_and_Visualforce

Inline Editing
Available in: All Editions

With Winter '08, you can now edit data with greater ease and speed using inline editing. Inline editing allows users to quickly
change field values on a record's detail page, saving the user from having to access the record's edit page first. When users
hover over a field's value, Salesforce displays a pencil ( ) if the field is editable or a lock ( ) if the field is not.

Implementation Tips

• If you have made changes to a record but have not yet saved it, you can undo individual changes without losing the rest of
your changes on the page. To undo a single edit, click the undo icon ( ) to the right of the desired field's changed value.
This reverts the field back to its previous value.

• You can use inline editing to change the values of fields on records for which you have read-only access, either via field-level
security or your organization's sharing model; however, Salesforce does not let you save your changes, and displays an
insufficient privileges error message when you try to save the record.

• Pressing Enter while your cursor is in a field's edit box confirms the change for that field only. Pressing Enter when no
fields are in edit mode saves all edits made to the record.

• Pressing Esc while your cursor is in a field's edit box reverts the change for that field only.
• Inline editing is available on detail pages for all fields that are editable on edit pages, with the exception of some fields on

tasks, events, opportunities, pricebooks, and documents. Inline editing is not supported in the console or Customer Portal.
• Inline editing is disabled on record detail pages if an administrator overrides the Edit button for that object with an s-control

or a Visualforce page. For information on overriding buttons with s-controls, see "Overriding Standard Buttons and Tab
Home Pages" in the Salesforce online help. For information on Visualforce pages, see What is Visualforce? on page 23.

29

Force.com Platform Inline Editing

http://www.salesforce.com/us/developer/docs/pages/index.htm
http://wiki.apexdevnet.com/index.php/Apex_and_Visualforce


• Removing the Edit button from a page layout does not prevent users from modifying the record using inline editing. To
prevent users from editing data altogether, administrators should use any combination of sharing rules, field-level security,
page layout field properties, validation rules, profile permissions, s-controls or Visualforce pages.

• Inline editing is unavailable for users with accessibility mode enabled.
• You cannot use inline editing on setup pages.
• Solution descriptions cannot be modified using inline editing if HTML solutions are enabled.

Best Practices

• Notify your users when you activate inline editing.

About Inline Editing

Enabling Inline Editing

To enable inline editing:

1. Click Setup ➤ Customize ➤ User Interface.
2. Select the Enable Inline Editing checkbox.

Note: The Enable Inline Editing checkbox is not selected by default, but you can enable it for every user
in your organization by selecting the checkbox. You cannot enable inline editing for a subset of users.

3. Click Save.

Editing Data Using Inline Editing

User Permissions Needed

"Customize Application"To enable inline editing:

Inline editing allows users to quickly change field values on a record's detail page, saving the user from having to access the
record's edit page first.

To enable inline editing for your organization, see "Customizing User Interface Settings" in the Salesforce online help.

To edit a record using inline editing once it has been enabled for your organization:

1. Navigate to the detail page of the record you want to edit.
2. Mouse-over the field you want to change. One of the following occurs:

• If inline editing can be used to edit the field, Salesforce displays a pencil icon ( ).
• If inline editing cannot be used to edit the field but the field is editable by other means, no icon appears.
• If the field cannot be edited by any means (such as the Last Modified By field), Salesforce displays a lock icon ( ).

3. Double-click inside the highlighted region next to the field you want to change.The field changes to edit mode. Salesforce
displays compound fields (such as addresses, first and last names, and dependent picklists) in a dialog box so that all portions
of the field can be edited.

4. Enter the new value.
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5. Click away from the field to confirm your change and continue making additional edits. If you are editing a field that is
not a text area field, you can also press Enter to confirm your change. Confirmed changes display in bold orange text.

6. Press Enter again or click Save to commit all confirmed changes.

Important: Salesforce does not save confirmed changes to field values until you commit them by pressing the
Enter key a second time or clicking Save. Navigating away from the page without committing changes cancels all
edits made to the record.

Note the following:

• If you have made changes to a record but have not yet saved it, you can undo individual changes without losing the rest of
your changes on the page. To undo a single edit, click the undo icon ( ) to the right of the desired field's changed value.
This reverts the field back to its previous value.

• You can use inline editing to change the values of fields on records for which you have read-only access, either via field-level
security or your organization's sharing model; however, Salesforce does not let you save your changes, and displays an
insufficient privileges error message when you try to save the record.

• Pressing Enter while your cursor is in a field's edit box confirms the change for that field only. Pressing Enter when no
fields are in edit mode saves all edits made to the record.

• Pressing Esc while your cursor is in a field's edit box reverts the change for that field only.
• Inline editing is available on detail pages for all fields that are editable on edit pages, with the exception of some fields on

tasks, events, opportunities, pricebooks, and documents. Inline editing is not supported in the console or Customer Portal.
• Inline editing is disabled on record detail pages if an administrator overrides the Edit button for that object with an s-control

or a Visualforce page. For information on overriding buttons with s-controls, see "Overriding Standard Buttons and Tab
Home Pages" in the Salesforce online help. For information on Visualforce pages, see What is Visualforce? on page 23.

• Removing the Edit button from a page layout does not prevent users from modifying the record using inline editing. To
prevent users from editing data altogether, administrators should use any combination of sharing rules, field-level security,
page layout field properties, validation rules, profile permissions, s-controls or Visualforce pages.

• Inline editing is unavailable for users with accessibility mode enabled.
• You cannot use inline editing on setup pages.
• Solution descriptions cannot be modified using inline editing if HTML solutions are enabled.

Tagging
Available in: All Editions

Tagging is now available with Winter '08, allowing users to describe and organize their data in a personalized way by associating
words or short phrases with Salesforce records. Tags allow users to group records from various objects by a common topic or
use, and then search on those tags to make finding information fast and intuitive.

For example, if a user met a number of contacts and leads at a conference, she might tag them all with the phrase User Conference
2007. She could then search for the User Conference 2007 tag in Sidebar or Advanced Search to retrieve those records.

Implementation Tips

• Administrators can enable tags on accounts, activities, assets, campaigns, cases, contacts, contracts, documents, events,
leads, notes, opportunities, reports, solutions, tasks, and any custom objects.

• Tags are private for every user. That is, any tag that a user adds to a record can only be viewed by that user.
• A user is limited to a maximum of 500 unique tags, and 5,000 instances of tags applied to records. Across all users, an

organization is limited to 5,000,000 instances of tags applied to records.
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• Once you have enabled tags for your organization, add the View Personal Tags component to your users' sidebar by clicking
Setup ➤ Customize ➤ Home ➤ Home Page Layouts and editing the appropriate home page layouts.

• If you want the View Personal Tags component to appear on all pages and not just the Home tab, click Setup ➤ Customize
➤ User Interface, and select Show Custom Sidebar Components on All Pages.

Best Practices

• Tags can only contain alphanumeric characters, spaces, dashes, and underscores, and must contain at least one letter or
number.

• As you enter new tags, up to ten tags that have already been defined are displayed as auto-complete suggestions. As you
type, the list of suggestions changes to show only those tags that match the prefix you have entered. To choose one of the
suggestions, click on it or press the Tab key.

• You can view a list of records that have a particular tag by clicking the tag in any detail page, the View Personal Tags
sidebar component, or in the Personal Tags page.The list of matching records appears on the Personal Tags page, organized
by object. You can narrow your results further by clicking additional tags.

• If you remove the last instance of a tag from a record, the tag is deleted completely from the Personal Tags page. If other
records use the tag, the tag still appears in the Personal Tags page.

• If you have multiple tags that are similar (for example, "biking", "cycling", and "bicycle"), you can consolidate them in the
Personal Tags area by selecting them, clicking Rename Personal Tags, and then entering a new tag name. All instances
of each selected tag are changed to the value you specified.

Setting Up and Using Tags

About Tagging

Tags are words or short phrases that users can associate with most Salesforce records to describe and organize their data in a
personalized way. Tags allow users to group records from various objects by a common topic or use, and then search on those
tags to make finding information fast and intuitive.

For example, if a user met a number of contacts and leads at a conference, she might tag them all with the phrase User
Conference 2007. She could then search for the User Conference 2007 tag in Sidebar or Advanced Search to retrieve
those records.

Administrators can enable tags for accounts, activities, assets, campaigns, cases, contacts, contracts, documents, events, leads,
notes, opportunities, reports, solutions, tasks, and any custom objects ("except relationship group members" in the Salesforce
online help), which allows users to:

• Add tags to any record the user can view, either by creating a new tag with free-form text entry, or by selecting from tags
the user has already created

• Remove tags from a record
• View tags on an individual record

See Tagging Records on page 33 for information.

Once tags are assigned to records, users can:

• Search for tags from Sidebar or Advanced Search
• Browse tags alphabetically, by frequency of use, or by recency of use
• View all records with one or more assigned tags
• Rename tags or merge tags that are similar or redundant
• Delete tags that are no longer needed, sending them to the Recycle Bin
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See Browsing, Searching, and Managing Tags on page 34 for information.

Tags are private for every user. That is, any tag that a user adds to a record can only be viewed by that user. A user is limited
to a maximum of 500 unique tags, and 5,000 instances of tags applied to records. Across all users, an organization is limited
to 5,000,000 instances of tags applied to records.

Enabling Tags

User Permissions Needed

"Customize Application"To modify tag settings:

To change your organization's tag settings:

1. Click Setup ➤ Customize ➤ Tags.
2. Select Enable Personal Tags if you want to allow users to add personal tags to records. Deselect this option if you

want to disable tagging.
3. If you are enabling tags, specify which objects and page layouts should display a tag section. The tag section is the only

way that a user can add tags to a record.

For example, if you only select one or more account page layouts, users in your organization can only tag account records.

Note:

• When tags are enabled, you can also add a tag section to a page layout by editing the page layout directly. See
"Customizing Page Layouts" in the Salesforce online help.

• Customer Portal users cannot view the tags section of a page, even if it is included in a page layout.

4. Click Save.

Adding the View Personal Tags Component to the Sidebar

Once you have enabled tags for your organization, you can add the View Personal Tags component to your user's sidebar.
This component allows users to navigate to the Tags page where they can browse, search, and manage their personal tags. It
also lists each user's most recently used tags. To add this component:

1. Click Setup ➤ Customize ➤ Home ➤ Home Page Layouts.
2. Next to a home page layout that you want to modify, click Edit.
3. Select the Personal Tags checkbox and click Next.
4. Arrange the Personal Tags component on your home page as desired, and click Save.

Tip: If you want the View Personal Tags component to appear on all pages and not just the Home tab, click Setup
➤ Customize ➤ User Interface, and select Show Custom Sidebar Components on All Pages.

Tagging Records

User Permissions Needed

"Read" on the recordTo edit tags on a record:

To tag a record:
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1. On the record detail page, click Add Personal Tags in the Personal Tags area just under the colored title bar. If the record
already has associated tags, click Edit Personal Tags instead.

2. In the Personal Tags text box, enter a comma-separated list of the tags that you want to associate with the record. Tags
can only contain alphanumeric characters, spaces, dashes, and underscores, and must contain at least one letter or number.

As you enter new tags, up to ten tags that have already been defined are displayed as auto-complete suggestions. As you
type, the list of suggestions changes to show only those tags that match the prefix you have entered. To choose one of the
suggestions, click on it or press the Tab key.

3. Click Save.

To remove a tag from a record:

1. On the record detail page, click Edit Personal Tags in the Personal Tags area just under the colored title bar.
2. In the Personal Tags text box, delete the tag that you want to remove from the record.
3. Click Save.

If the tag that you removed is the last instance of the tag, the tag is deleted completely. If other records use the tag, the tag
still appears in the Personal Tags page.

A user is limited to a maximum of 500 unique tags. If you attempt to tag a record with a new tag that exceeds this limit, the
tag is not saved. You can delete tags from the Personal Tags page. See Browsing, Searching, and Managing Tags on page 34.

Browsing, Searching, and Managing Tags

You can browse, search, and manage tags in the Personal Tags page. To access this page, click View Personal Tags in the
sidebar, or click the name of any tag on a detail page.

The Personal Tags page displays a list of all tags that you have defined in your organization. Each tag includes a number in
parentheses that indicates how many records are associated with that tag. Because tags are private, you can only see the tags
that you have defined; you cannot see the tags of other users.

Note: The number of records associated with a tag can sometimes be greater than the number of records displayed
when you click that tag in the Personal Tags page.This situation occurs if you tagged a record and then lost permission
to view it because of a change in permissions.

Finding Records with Tags

You can view a list of records that have a particular tag by clicking the tag. The list of records appears below the tag browsing
area, organized by object. You can narrow your results further by clicking additional tags. Click Clear Selected Tag(s) to
deselect all tags and start over.

As with regular search results, you can select and reorder the columns that appear for each object, and filter the search results
by particular values. See "Viewing Search Results" in the Salesforce online help.

Browsing Tags

You can browse through your tags by clicking a letter at the top of the tag browsing area to view only tags that begin with that
letter, or by using the Next Page and Previous Page links at the bottom.

By default, tags are listed in alphabetical order. You can also choose By Number of Uses from the Sort picklist to sort tags
by the number of records that are tagged by them, or choose By Most Recently Used to sort tags by how recently they were
added to a record.

Searching Tags

You can search tags by entering a search string in the Search Personal Tags text box and clicking Search. Only tags that meet
your search criteria are listed in the tag browsing area. You can then click any tag to view records associated with that tag.
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Search strings must include at least two characters to return results, and can also include wildcards and other special operators.
See "Search Wildcards and Operators" in the Salesforce online help.

The most recent search result is saved in the tag browsing area next to the alphabet at the top of the page. Click the search
string to return to your results.

Managing Tags

The Personal Tags page also allows you to rename and delete your tags.

To rename one or more tags:

1. Click Rename Personal Tags.
2. Select one or more tags in the tag browsing area that you want to rename. If you already had tags selected before clicking

Rename Personal Tags, the tags are prepopulated in the Rename Personal Tags area. You can deselect a tag by clicking
it again, or by clicking Clear.

3. Enter a new name for the tag in the New Tag Name text box.
4. Click Save. If you are renaming more than one tag, confirm the change by clicking OK in the dialog that appears. All

instances of each selected tag are changed to the value you specified.
5. Click Hide to hide the Rename Personal Tags area.

To delete one or more tags:

1. Click Delete Personal Tags.
2. Select the tags in the tag browsing area that you want to delete. If you already had tags selected before clicking Delete

Personal Tags, the tags are prepopulated in the Delete Personal Tags area. You can deselect a tag by clicking it again, or
click Clear to deselect all selected tags at once.

3. Click Delete. All selected tags are removed from every record in your organization and are placed in the Recycle Bin.
4. Click Hide to hide the Delete Personal Tags area.

Using the View Personal Tags Sidebar Component

The View Personal Tags drop-down list, available in the sidebar, allows you to browse tags and access your most recently used
tags:

• Select View All Personal Tags to browse, search, and manage your entire tag collection.
• Select an individual tag to view all records that have been marked with that tag. The tags that appear in the View Personal

Tags drop-down list are those you have most recently used to tag records.

Mobile Administration Console
Available in: Unlimited Edition

Available for an additional cost in: Professional and Enterprise Editions

Salesforce Mobile allows users to access their Salesforce data from mobile devices running the mobile client application. With
Winter '08, administration of Salesforce Mobile is now even easier. You can use the Mobile Administration Console within
the Salesforce setup pages to manage the full life-cycle of your mobile deployment, including configuration, customization,
and installation. This solution lets you maintain devices on different platforms and make changes to mobile configurations
completely over-the-air.
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Implementation Tips

• Current mobile customers should contact salesforce.com to find out how to migrate from the legacy Apex Mobile console
to the new Mobile Administration Console.

• For organizations using Unlimited Edition, salesforce.com provides one mobile license for each Salesforce license.
Organizations using Professional or Enterprise Editions must purchase mobile licenses separately.

• The mobile version of Salesforce requires some additional setup in order to define what data is sent to users' devices. See
"Defining Data Sets" in the Salesforce online help.

• You can mobilize accounts, contacts, opportunities, leads, tasks, events, price books, products, cases, solutions, and custom
objects. You cannot mobilize s-controls, formula fields, merge fields, or custom links.

• User permissions are inherited from Salesforce.
• The mobile application uses the default page layouts set up in Salesforce. You can exclude fields from the mobile data set

to make pages easier to navigate and reduce the amount of data sent to users' devices. See "Customizing Mobile Page
Layouts" in the Salesforce online help.

• Each user can have only one assigned mobile device in Salesforce. See "Managing Mobile Devices" in the Salesforce online
help.

• After you complete the mobile setup, users must download and install the Salesforce Mobile client application on their
devices.

• The mobile application can run on BlackBerry, Palm, and Windows Mobile operating systems. For a list of the supported
devices on each platform, see "Salesforce Mobile Supported Devices" in the Salesforce online help.

• Administrators deploying to BlackBerry users must consider several technical factors, including the corporate network
infrastructure, device model and memory requirements, and hosted server restrictions. For detailed information, see the
Salesforce Mobile Implementation Guide.

Best Practices

• Define the mobile objectives of your users so that you do not mobilize unnecessary data. Some users might only need access
to cases and solutions, while others might need access to contacts and opportunities.

• For ease of administration, we recommend that you use assign mobile configurations to profiles; however, you may have
situations in which you need to assign a configuration directly to individual users.

• To reduce the amount of data delivered to users' devices, limit the scope of your mobile configurations. When possible,
set the filtering option to Search Only so that users can search and download the records they want without automatically
receiving records on the device.

• After setting up the Mobile Administration Console, deploy the mobile application on a limited basis with a select group
of users. Adjust the mobile setup based on their feedback, and then deploy to all of your users.

About the Mobile Administration Console

Administration Overview

To deploy Salesforce Mobile to your organization, first create one or more mobile configurations. Mobile configurations are
sets of parameters that determine the data Salesforce transmits to users' mobile devices, and which users receive that data on
their mobile devices. Organizations can create multiple mobile configurations to simultaneously suit the needs of different
types of mobile users. For example, one mobile configuration might send leads and opportunities to the sales division, while
another mobile configuration sends cases to customer support representatives.

After you add users to a mobile configuration, send them a mass email with a link to install the correct mobile client application
on their mobile devices. After installing the client application, users can use the client interface to easily register their devices
with Salesforce. Administrators can view information about registered devices and manage mobile users. For more information,
see "Managing Mobile Devices" in the Salesforce online help.
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Managing Mobile Configurations

User Permissions Needed

"View Setup and Configuration"To view mobile configurations:

"Manage Mobile Configurations"To create, change, or delete mobile configurations:

To manage your Salesforce Mobile configurations, click Setup ➤ Mobile Administration ➤ Mobile Configurations.

• To define a mobile configuration, click New Mobile Configuration. See "Creating Mobile Configurations" in the Salesforce
online help.

• To define data sets for a mobile configuration, click the name of the mobile configuration, then click Edit in the Data Sets
related list. See "Defining Data Sets" in the Salesforce online help.

• To exclude fields from the mobile page layouts for a mobile configuration, click the name of the mobile configuration,
then click Edit next to an object name in the Fields Excluded Per Object related list. See "Customizing Mobile Page
Layouts" in the Salesforce online help.

• To make changes to a mobile configuration, click Edit.
• To delete a mobile configuration, click Del.
• To view details about a mobile configuration, click its name.
• To clone a mobile configuration, select the mobile configuration you want to clone and click Clone.
• To activate a mobile configuration, click Edit next to the mobile configuration you want to activate, select Active, and

click Save. Deselect Active to deactivate the mobile configuration.

Creating Mobile Configurations

User Permissions Needed

"View Setup and Configuration"To view mobile configurations:

"Manage Mobile Configurations"To create, change, or delete mobile configurations:

To create a mobile configuration:

1. Enable Users for Salesforce Mobile
2. Enter Basic Information
3. Assign Users and Profiles
4. Set Total Data Size Limit
5. Complete Your Mobile Configuration

Enable Users for Salesforce Mobile

Before creating your mobile configurations, plan which profiles and users you want to assign to each configuration. Each
mobile configuration only affects the mobile devices of users assigned to it. Users who are not assigned to a mobile configuration
cannot access Salesforce from a mobile device.

You can assign individual users and profiles to each mobile configuration. If you assign a profile to a mobile configuration,
the mobile configuration applies to all Salesforce Mobile users with that profile unless a specific user is assigned to another
mobile configuration.
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Tip:  For ease of administration, we recommend that you use assign mobile configurations to profiles; however, you
may have situations in which you need to assign a configuration directly to individual users.

For each user you want to assign to a mobile configuration:

1. Edit the user's record. For information, see "Editing Users" in the Salesforce online help.
2. Select the Mobile User checkbox. Users must have this checkbox selected to use Salesforce on a mobile device. This

checkbox is enabled by default for Unlimited Edition users. To prevent users from activating Salesforce on their mobile
devices before you are ready to deploy mobile in your organization, disable the checkbox for all your users.

If you deselect this checkbox for a user who is already assigned to a mobile configuration, Salesforce removes that user
from the mobile configuration. For information on the Mobile User checkbox, see "User Fields" in the Salesforce online
help.

Enter Basic Information

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations to access the mobile configurations list page.
2. Click New Mobile Configuration.
3. Enter a name for the mobile configuration.
4. Select the Active checkbox if you want to activate the mobile configuration immediately after creating it. The mobile

configuration does not work until you select this checkbox.

If you deactivate an active mobile configuration, Salesforce saves all requests from devices of the users assigned to the
mobile configuration for up to one week. If you reactivate the mobile configuration, Salesforce executes those requests in
the order received.

5. Optionally, enter a description for the mobile configuration.

Assign Users and Profiles

To assign users and profiles to a mobile configuration:

1. In the Search drop-down list, select the type of member to add: users or profiles. This drop-down list is not available if
you have not enabled the Mobile User checkbox on any user records, or if all users are already assigned to a mobile
configuration; in that case, you can only assign profiles to this mobile configuration.

2. If you do not immediately see the member you want to add, enter keywords in the search box and click Find.
3. Select users and profiles from the Available Members box, and click the Add arrow to add them to the mobile configuration.

You can assign each user and profile to only one mobile configuration. Once you assign a user or profile to a mobile
configuration, the Available Members boxes in other mobile configurations do not list that user.

The Available Members box only displays users who have the Mobile User checkbox enabled.  For information on this
checkbox, see "User Fields" in the Salesforce online help.

4. If there are users or profiles in the Assigned Members box you do not want to assign to this mobile configuration, select
those users and click the Remove arrow.

Caution:  Removing a user from an active mobile configuration deletes the Salesforce-related data on the user's
mobile device but does not delete the client application.

Set Total Data Size Limit

Different types of mobile devices offer different memory capacities, and some devices experience serious problems if all of the
flash memory is used.To avoid overloading mobile devices, optionally specify a total data size limit for each mobile configuration.
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The total data size limit prevents Salesforce from sending too much data to the mobile devices of users assigned to the mobile
configuration.

To set the total data size limit, use the Don't sync if data size exceeds drop-down list to specify the amount of
memory that is consistently available on the mobile devices of users who are assigned to this mobile configuration. If the
combined size of all the data sets exceeds this limit, users assigned to this profile receive an error message on their mobile
devices, and Salesforce will not synchronize any data sets in this mobile configuration. Test your mobile configuration to make
sure the data sets do not exceed the total data size limit.

Tip: To reduce the size of your data, do one or more of the following:

• Delete a data set.
• Reduce the scope of your data sets.
• Refine the filter criteria of your data sets.

Complete Your Mobile Configuration

Click Save when you are done. Note that your mobile configuration is not active until you select the Active checkbox.

Next, define the data sets for this mobile configuration to determine the data that members of the mobile configuration receive
on their mobile devices and test the configuration to verify that the data size limit for a user's device will not be exceeded.

After creating mobile configurations and defining the data sets, send a mass email to mobile users explaining how to register
their mobile devices.The registration process creates device records in Salesforce, which allows you to manage your organization's
mobile devices.

Defining Data Sets

User Permissions Needed

"View Setup and Configuration"To view mobile data sets:

"Manage Mobile Configurations"To create, change, or delete mobile data sets:

Accessing Salesforce from a mobile device is very different than accessing it from your computer.This is because mobile devices
generally have less memory and screen size than computers, and do not maintain a constant network connection. To work
with these limitations, each Salesforce mobile configuration only transfers data sets, which are subsets of the records users
access in the Salesforce online user interface. Mobile devices store data sets in on-board databases, allowing users to access
their most important records and work offline when no network connection is available. Salesforce automatically synchronizes
the on-board databases when the mobile device reestablishes a network connection.

Each data set can contain records related to a single object, and is classified by the name of that object. For example, the
Accounts data set only includes account records.

Data sets can have child data sets, which are data sets that contain records associated with a top-level (parent) data set. For
example, if the first level of your hierarchy has an Accounts data set, you can add a Contacts child data set that includes all
contact records related to the account records. Child data sets appear as related lists on mobile devices.

A single mobile configuration can have multiple data sets for the same object, and at different levels. For example, you can
have an Events parent data set and an Events child data set under Leads.

After creating a mobile configuration, you must define its data sets. To access the data sets for a mobile configuration:

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations, and click the name of the mobile configuration you
want to modify.

2. In the Data Sets related list, click Edit.
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3. From the Data Sets page, you can:

• Add a data set.
• Remove a data set by selecting the data set you want to remove and clicking Remove.
• Edit a data set by selecting the data set you want to edit in the hierarchy. The right pane displays the filters for that

data set.
• Test your mobile configuration.

As you define and modify the data sets, Salesforce automatically saves your changes.

4. Click Done when you are finished.

Adding Data Sets

To add a data set:

1. In the hierarchy, select Data Sets to create a parent data set, or select an existing data set to create a child data set.
2. Click Add....
3. In the popup window, select the object for the records you want the data set to include. Salesforce lets you create parent

data sets for all custom objects and the following standard objects:

• Accounts
• Cases
• Contacts
• Events
• Leads
• Opportunities
• Products
• Solutions
• Tasks

For child data sets, the popup window only lists objects that relate to the selected parent data set.

Note: Salesforce automatically transfers parent records of objects if that type of parent record is anywhere in the
data set, even if the parent object is not connected to the child object in the hierarchy.

4. Click OK. The data set you created appears in the hierarchy.
5. Optionally, use filters to restrict the records that a parent or child data set includes:

a. Use the Filter by Record Ownership options to configure Salesforce to automatically synchronize records based on the
owner of the record. The possible options are:

• All Records: Salesforce automatically synchronizes all records the user can access.
• User's Records: Salesforce automatically synchronizes all records the user owns.
• User's Team's Records: Salesforce automatically synchronizes all records owned by the user and the user's

subordinates in the role hierarchy.
• User's Account Team's Records: Salesforce automatically synchronizes all records owned by the other

members of the user's account team, but does not include the user's records.
• User's Sales Team's Records: Salesforce automatically synchronizes all records owned by the other members

of the user's sales team, but does not include the user's records.
• None (Search Only): Salesforce does not automatically synchronize any records for this data set; however, users

can use their mobile devices to search all of the records they can access.
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Salesforce only displays options that relate to the selected data set. For example, selecting an account data set displays
the User's Account Team's Records option, while selecting an opportunity data set displays the User's Sales
Team's Records option.

b. Set the filter criteria to automatically synchronize only records that meet specific criteria in addition to the Filter by
Record Ownership option you selected. For example, you can set the filter to only include opportunity records with
amounts greater than $50,000, or contact records with the title "Buyer." Click Advanced Options to change the default
AND relationship between each filter. For tips on entering advanced filter conditions, see "Working with Advanced
Filter Conditions" in the Salesforce online help.

If you selected the None (Search Only) Filter by Record Ownership option, the filter criteria you select does not
apply because no records are automatically synchronized.

c. To prevent a single data set from consuming all the memory on a mobile device, select the second radio button under
Set Max Record Limit and enter the maximum number of records this data set can transfer to mobile devices. Use the
Order By and Sort drop-down lists to specify which records are synchronized if the data size limit is exceeded.

If the limit is reached, Salesforce updates the records currently on the mobile device approximately every 20 minutes,
and replaces the records approximately every 24 hours in accordance with the Order By and Sort settings. For example,
if the settings are Last Modified Date and Descending, Salesforce transfers the most recently modified records to
mobile devices and removes the same number of records that were least recently modified.

If you selected the None (Search Only) Filter by Record Ownership option, the limit you set does not apply because
no records are automatically synchronized.

Tip:  Do not use Set Max Record Limit in place of filters. Only use Set Max Record Limit as a safety mechanism,
and use filters as the primary means of limiting the number of records on a mobile device. This ensures that
your mobile users receive the correct records on their devices.

6. Be sure to test your mobile configuration to make sure the data does not exceed the total data size limit.
7. Click Done when you are finished.
8. After creating mobile configurations and defining the data sets, send a mass email to mobile users explaining how to register

their mobile devices. The registration process creates device records in Salesforce, which allows you to manage your
organization's mobile devices.

Tip: You can specify which fields the mobile client application displays. For more information, see "Customizing
Mobile Page Layouts" in the Salesforce online help.

Customizing Mobile Page Layouts

User Permissions Needed

"View Setup and Configuration"To view mobile configurations:

"Manage Mobile Configurations"To exclude fields from mobile page layouts:

The mobile client application inherits the user's page layouts from Salesforce. Administrators may want to exclude some fields
from each object's mobile page layout because unnecessary fields consume memory and make it harder for users to scroll
through pages on the mobile device.

Mobile page layouts are set up per mobile configuration.To exclude fields from the mobile page layout for a mobile configuration:

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations.
2. Click the name of the mobile configuration you want to modify.
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3. In the Fields Excluded Per Object related list, click Edit next to an object name.

Only objects you mobilized in the configuration's data set appear in the related list.

4. Select which fields to display on the mobile device for this object. To add or remove fields, select a field name, and click
the Add or Remove arrow.

• Mobile administrators can view all available fields per object, regardless of field-level security.
• Certain fields are required in order for the mobile client application to communicate with Salesforce. Those fields do

not display in the Available Fields box because they are mandatory and cannot be excluded from mobile page layouts.

5. Click Save when finished.

Testing Mobile Configurations

User Permissions Needed

"View Setup and Configuration"To view mobile data sets:

"Manage Mobile Configurations"To test mobile configurations:

When you create a mobile configuration, you specify a total data size limit for the configuration. The total data size limit
prevents Salesforce from sending too much data to the mobile devices of users assigned to the mobile configuration. After
defining the data sets, it is important to test the mobile configuration to make sure the total data size limit is not exceeded.

To estimate the size of the data set that the mobile configuration will deliver to a user's device:

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations, and click the name of the mobile configuration you
want to test.

2. In the Data Sets related list, click Edit.
3. In the Test Data Size section, click the lookup icon next to the Select a user field to choose the user you want to test.

While users must be mobile-enabled in order to assign them to mobile configurations, you can test the configuration's
data size against any user account.

The Select a user field defaults to the name of the user currently logged in; however, it is important to test a mobile
configuration with the accounts of users who will actually be assigned to the configuration, particularly users who own a
large number of records.

4. Click Estimate Data Size.

The size of each data set is calculated. Results display in the hierarchy, which is the left pane of the data set region at the
top of the page. Additional results appears in the Test Data Size section below the hierarchy.

• In the hierarchy, two numbers appear next to each data set. The first represents the number of records generated by
the data set, and the second represents the total size of the data set. This breakdown is useful for identifying which
data sets might require additional filtering criteria to reduce the size.

• The Test Data Size section provides an estimate of the total data that would be delivered to the selected user's device
with the current mobile configuration. Separate totals are listed for each mobilized object. The results also include the
number of marked records associated with the user's account. A marked record is a record that is not part of a user's
mobile configuration; the user downloaded the record to his or her device through an online search, and the record was
flagged so that it gets sent to the user's device every time the device synchronizes with Salesforce.

• Reports are not included in the data size estimate.
• The data size estimate does not include metadata, which consists of page layout and schema information. The actual

size of the data delivered to the device will be slightly larger than the estimate, but the metadata does not count toward
the data size limit.
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5. Compare the test results to the total data size limit that was set for the configuration; the limit is located in the top of the
Test Data Size section. Click the size limit to increase or decrease the value on the Edit Mobile Configuration page.

• If the total data size is below the limit, the selected user can safely be assigned to the mobile configuration. However,
keep in mind that the test results are an estimate because different devices have different storage algorithms.

• If the total data size exceeds the limit, reduce the size of the data by reducing the scope of your data set, refining the
filter criteria of your data sets, deleting a data set, or removing fields from the page layout. Repeat the testing process
until the data is below the total limit. For instructions, see "Adding Data Sets" in the Salesforce online help and
"Customizing Page Layouts" in the Salesforce online help.

Note: The data size estimate in the Test Data Size section does not automatically refresh if you edit the data
sets. Click Refresh Data Size to update the test results.

Sending Emails to Mobile Users

After creating mobile configurations and defining data sets, mobile-enabled users in your organization can download the
Salesforce Mobile client application to their devices and begin using Salesforce wirelessly. The most effective way to notify
users about the availability of the mobile application and provide installation instructions is by sending mass email. Here is a
brief description of the steps:

1. Create an email template informing users about the initial installation. Optionally, create a separate email template for
upgrade notifications. In both templates, be sure to include the URL that launches the download:
http://mobile.salesforce.com/setup. The link is the same for the initial download and for subsequent upgrades. Users can
click the link in the email on their device, or they can open their phone's Web browser and navigate to the URL. For more
information about email templates, see "Managing Email Templates" in the Salesforce online help.

2. Create a custom view on the Mass Email page showing only mobile users.
3. Send mass email to your mobile users using the custom view that you created.

Important:  It is essential for the success of your mobile deployment to set up the email templates and email your
mobile users. If you skip this step, users will not know about the mobile product and therefore will not be able to use
it.

Managing Mobile Devices

User Permissions Needed

"View Setup and Configuration"To view mobile devices and users:

"Manage Mobile Configurations"To manage mobile devices:

After you assign users to mobile configurations, they can download and install the Salesforce Mobile client application on
their wireless devices. When a user logs in to the mobile application the first time, Salesforce collects the device information
and associates the device with his or her user record. The device information is read only. While the device entry is created
automatically, you can still view and manage all the mobile users and devices in your organization by clicking Setup ➤ Mobile
Administration ➤ Mobile Users and Devices.

From the All Mobile Users and Devices page:

• You can view the list of users in your organization who have been enabled to use Salesforce Mobile.
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• You can create custom list views to see different subsets of your mobile users (see "Creating Custom List Views" in the
Salesforce online help). For example, create a view that shows the mobile users who have never logged in to Salesforce
from their devices to evaluate your organization's mobile deployment efforts.

• To view details about a mobile device, click the device address. See "Viewing Mobile Device Information" in the Salesforce
online help to find out more about device details.

• To view details about a specific user, click the username.
• To view details about a mobile configuration, click the mobile configuration name.
• The buttons on the All Mobile Users and Devices page let you perform actions on multiple mobile users at one time. You

can adjust the mobile session timeout value and erase the Salesforce data from users' devices.
• You cannot delete a device from the All Mobile Users and Devices page. A device is removed from a user's record only

when it is activated by another Salesforce user.

Note: You can also manage mobile users from the Assigned Mobile Devices related list on the user detail page.

Viewing Mobile Device Information

Salesforce collects information about a mobile user's device the first time the user logs in to the mobile application. There are
two ways to access the device details:

• Click Setup ➤ Mobile Administration ➤ Mobile Users and Devices, and then click a device address in the list view.
• Click Setup ➤ Manage Users ➤ Users. Click Edit next to a user's name, and then click the device address in the Assigned

Mobile Devices related list.

From the Mobile Device page, you can review device information, adjust the mobile session timeout value, and erase the
Salesforce data from users' devices. Below is a description of the fields in alphabetical order that are stored for each mobile
device in your organization.

DescriptionField

The brand of the mobile device, if available.Brand

The name of the carrier providing service for the mobile device,
if available.

Carrier

The date and time the device established a connection to the
mobile server.The device loses a connection when the battery

Connected Since

dies or when the session is closed because the server has not
received data from the device for a long period of time.

The state of the device connection. Possible values for this
field are Connected, Not Connected, and Not Available.

Connection Status

The name of the first user who registered the mobile device
and the time and date the registration occurred.

Created By

The unique PIN of the user's mobile device.Device Address

The model of the mobile device.Device Model

The version number and build number of the mobile client
application installed on the device.

Salesforce Mobile Version

A flag indicating whether the device is a simulator or a mobile
device. A simulator is a software application that emulates the
behavior of a mobile device.

Is Simulator?

44

Force.com Platform Mobile Administration Console



DescriptionField

The last time a full data set was downloaded to the mobile
device. If a user's data set exceeds the limit defined in the

Last Activated

assigned mobile configuration, the device can be registered
but not activated.

The last time data was received from the device. This
information is helpful for troubleshooting connection issues.

Last Data Received

The last time a user registered the mobile device. The
registration process creates the device record in Salesforce and
associates it with the user who registered it.

Last Registration

The manufacturer of the mobile device.Manufacturer

The name of the last user who registered the mobile device
and the time and date the registration occurred.

Modified By

The number of messages queued on the device waiting to be
sent to the mobile server. Because the server processes messages
almost instantaneously, this value is usually 0.

Number of Incoming Messages

The number of messages queued on the mobile server waiting
to be sent to the device.

Number of Outgoing Messages

The name and version number of the operating system
installed on the mobile device.

Operating System

The phone number associated with the mobile device.Phone Number

The total data size of the messages queued on the device
waiting to be sent to the mobile server. Because the server

Size of Incoming Messages (Bytes)

processes messages almost instantaneously, this value is usually
0.

The total data size of the outbound message queue on the
mobile server.

Size of Outgoing Messages (Bytes)

The Salesforce username of the user who is associated with
the mobile device.

Username

Setting Mobile Session Timeout Values

User Permissions Needed

"Manage Mobile Configurations"To set mobile session timeout values:

For security reasons, the mobile client application is set to lock out users after ten minutes of inactivity. Administrators can
adjust or disable this setting on a device-by-device basis. You might disable the timeout setting if the mobile device's operating
system has its own locking mechanism.

To change the mobile session timeout value:

1. Navigate to the Mobile Devices and Users page or the Mobile Devices page:

• Click Setup ➤ Mobile Administration ➤ Mobile Users and Devices. From the list view, you can select multiple
devices at one time.
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• Click Setup ➤ Manage Users ➤ Users. Click Edit next to a user's name, and then click the device address in the
Assigned Mobile Devices related list.

2. Click Set Mobile Session Timeout.
3. Choose the new timeout value in minutes. You also have the option to choose Never Expire if users should not be locked

out of the mobile application.
4. Click Save.

Salesforce attempts to send a message containing the new session timeout setting to the selected mobile devices.

5. A confirmation page summarizes the results for each mobile device you selected. See "Mobile Session Timeout Results"
in the Salesforce online help.

Mobile Session Timeout Results

After Salesforce sends the new session timeout session to the selected mobile devices, a results page provides information about
the status of each message. The table below describes the three possible outcomes:

DescriptionResult

The mobile server has sent the message to the device.
Salesforce cannot detect if the message was received by the
device.

Message successfully queued

A temporary communication problem between Salesforce and
the mobile server prevented the message from being sent. Try
again later.

Unable to send message

The selected mobile user never registered a device, so therefore
the message could not be sent.

No device to send message to

Erasing Mobile Data

User Permissions Needed

"Manage Mobile Configurations"To delete the mobile data on a device:

A mobile device activated by a Salesforce user contains both the mobile client application and a set of the user's Salesforce
data. An administrator can remove the data from a device without uninstalling the mobile application. This is an effective
security tool when a user misplaces his or her device. You also must erase a device's data if you plan to give it to another user.

To erase the Salesforce data on one or more mobile devices:

1. Navigate to the Mobile Devices and Users page or the Mobile Devices page:

• Click Setup ➤ Mobile Administration ➤ Mobile Users and Devices. From the list view, you can select multiple
devices at one time.

• Click Setup ➤ Manage Users ➤ Users. Click Edit next to a user's name, and then click the device address in the
Assigned Mobile Devices related list.

2. Click Erase Data, and then click OK.

Salesforce attempts to send a message to the mobile devices to erase the data.
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Erase Data Results

After Salesforce sends the message to the mobile devices to erase data, a results page provides information about the status of
each message. The table below describes the three possible outcomes:

DescriptionResult

The mobile server has sent the message to the device.
Salesforce cannot detect if the message was received by the
device.

Message successfully queued

A temporary communication problem between Salesforce and
the mobile server prevented the message from being sent. Try
again later.

Unable to send message

The selected mobile user never registered a device, so therefore
the message could not be sent.

No device to send message to

Apex
Available in: Unlimited and Developer Editions

Available for an additional cost in: Enterprise Edition

With Winter '08, Apex is now available as an add-on for Enterprise Edition. Apex also includes the following enhancements
in Winter '08:

Additions to Classes
Enums, which are a typed list of values, are now available as a type of class in Apex. You can specify it as
an outer class.

You can now specify an interface as an outer class.

Approval Processes
You can programmatically initiate and manage approval processes using the following method and classes:

• Process method
• ProcessRequest class
• ProcessResult class
• ProcessSubmitRequest class
• ProcessWorkitemRequest class

Database Methods for Partial DML Operations
Prior to Winter '08, all DML operations, such as insert or update, were only available as special
statements in Apex. In addition, there was no method for executing a partial DML operation. If a single
record failed, the entire operation failed.

Now, all DML operations can be executed using the Database.<dmlOperation>() system method
form. Executing DML operations with their system method form corresponds more closely to the way
DML statements are executed by the Force.com Web Services API.

The DML operations executed with their system method form accept a single parameter named
allOrNothing. If you specify false for this parameter and a record fails, the remainder of the DML
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operation can still succeed. In addition, the system method returns more information about the operation,
such as which records were inserted, which were updated, and so on.

Email
You can now send email using the sendEmail method. You can also use the Apex Email Service to
process inbound email with an Apex class.

The Apex Email Service is available in Developer Preview only.

Embedded System Methods
Prior to Winter '08, you could call embedded system methods, for example,System.System.Execption.
As of Winter '08, embedded system method calls generate an error when you try to save an Apex script.
For the example above, use System.Exception instead.

Enhanced Debugging
In addition to information about Apex script errors and the resources used by an Apex script, the debug
log now contains information about:

• Workflow rules
• Validation rules
• Assignment rules
• Escalation rules
• Auto-response rules
• Approval processes

Exception Syntax Change
Prior to Winter '08, all system exceptions had to be qualified with the system prefix. For example:

try {
// your code here

} catch (system.QueryException e) {
// your code here

}

In Winter '08, the system prefix is no longer required for exceptions. For example:

try {
// your code here

} catch (QueryException e) {
// your code here

}

Governor Limits by Namespace
Prior to Winter '08, all governor limits applied to your entire organization, including any managed
packages. In Winter '08, governor limits are specific to a namespace. For example, an app that is in a
managed package that you have installed from the AppExchange has access to 20 DML statements while
executing, and any Apex script that is native to your organization also has access to 20 DML statements.

HTTP Request and Response
You can now use Apex to programmatically create HTTP requests like GET, POST, PUT, and so on.
You can also use Apex to handle the HTTP response returned by the request.

New Data Types and Objects
You can now use blob, long, and decimal as data types for Apex.

You can now declare variables as the generic SObject type. These variables can be assigned any specific
SObject type value, such as an Account, Lead, or a custom object.
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Apex includes new data types to match the Force.com Web Services API input and result objects, such
as the new database methods, the approval processing methods, and the email messaging methods.

New DML Statements
Undelete is a new DML statement.

Top level SOQL statements can now use the ALL ROWS parameter. Using this parameter effectively
queries all rows for both top level and aggregate relationships, including deleted records and archived
activities.

New Methods
The exception class now includes the setCause and getCause methods.

The database class also now includes the convertLead and undelete methods.

Operations That Fire Triggers
The following operations now fire triggers:

• Mass updates to cases, including mass closing of cases
• Mass updates to leads

In addition, validation formulas now run when triggers execute due to a change in record owner.

System Test Execution
Customer-deployed code can be executed by salesforce.com for support and management purposes.
Salesforce.com will use this ability to verify that future upgrades do not cause regressions.

XMLStreamReader Class
Methods in the new XmlStreamReader class enable you to read an XML document from Apex.

Methods in the new EncodingUtil class enable you to encode and decode URL strings, and convert
strings to hexadecimal format.

Methods in the new Crypto class enable you to create a digest, message authentication code, or a signature
to be sent with an authorization header to external services that require encryption, such as Google's
AuthSub interface named gdata, or Amazon WebServices (AWS).

Apex Email Service
Available in: Developer Edition

Winter ’08 delivers unprecedented email capabilities. The Apex email service lets you use Apex classes to process the contents,
headers, and attachments of email received by a user-specific email service address. For example, using the Apex email service,
a developer can write an Apex class that automatically creates contact records by processing emails with contact information.
When an email with contact information is sent to the email service address associated with the Apex class, Salesforce uses
the class to process the email and create a new contact.

Implementation Tips

• The Apex email service is enabled by default for organizations using Developer Edition.
• Developers who are creating Apex classes for processing email must have the "Author Apex" permission.
• Each user is allowed a unique email service domain. The domain is used in the email service addresses to ensure that only

authorized users submit email to the email service.
• Users can optionally regenerate their email service domain if an unauthorized person obtains the email service address.
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Best Practices

• Request that your users keep their email service domains confidential.

About the Apex Email Service

What is the Apex Email Service?

User Permissions Needed

"Modify All Data"To generate Apex email service domains:

"Author Apex"To create Apex classes:

The Apex email service lets you use Apex classes to process the contents, headers, and attachments of email received by a
user-specific email service address. For example, using the Apex email service, a developer can write an Apex class that
automatically creates contact records by processing emails with contact information. When an email with contact information
is sent to the email service address associated with the Apex class, Salesforce uses the class to process the email and create a
new contact.

To get started:

1. Click Setup ➤ Build ➤ Email Services, then click Generate Domain to generate an Apex email service domain in
Salesforce.

An Apex email service domain is a Salesforce email domain that can receive email for processing by Apex. Each user can
have one Apex email service domain and can optionally regenerate the Apex email service domain at any time.

Caution:  If you click Generate Domain to regenerate an existing domain, you permanently delete your existing
Apex email service domain and replace it with a new one. Email addresses using the old Apex email service domain
will be invalidated. You must update the invalid email addresses with the regenerated domain.

2. Click New Apex Class to create Apex classes that utilize the inboundEmail object.

The Apex Email Service page lists any Apex class that has at least one method with a signature of the format:

Webservice static Messaging.InboundEmailResult
your_method_name(Messaging.InboundEmail email)

Note:  Replace your_method_name with the name of the method.

For information on the InboundEmail object, see "Using the InboundEmail Object" in the Salesforce online
help.

3. Click the Email Address link next to an existing Apex class on the Apex Email Service page to send an email to the email
address for that class. You can also right click the Email Address link and copy the email address. When you send email
to this address, Salesforce uses the associated Apex class to process the email.

To disable the Apex email service functionality after generating an Apex email service domain, click the Disable Domain
button.This permanently deletes your current Apex email service domain, and invalidates any email address using that domain.
It does not delete any of the Apex classes you have created. If you decide to use the Apex email service again after disabling
your Apex email service domain, you must generate a new domain.
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Using the InboundEmail Object

For every email the Apex email service domain receives, Salesforce creates a separate InboundEmail object that contains the
contents and attachments of that email. You can write Apex classes that access an InboundEmail object to retrieve the contents,
headers, and attachments of inbound email messages, as well as perform many functions.

Note:  For information on the Apex email service, see "What is the Apex Email Service?" in the Salesforce online
help.

Example

The following is an example of how you can look up a contact based on the inbound email address and create a new task.

global class emailExample {

Webservice static Messaging.InboundEmailResult createTask(Messaging.inboundEmail email){

// Create an inboundEmailResult object for returning the result of the Apex Email Service

Messaging.InboundEmailResult result = new Messaging.InboundEmailResult();

String myPlainText= '';

// Add the email plain text into the local variable

myPlainText = email.plainTextBody;

// New Task object to be created

Task[] newTask = new Task[0];

// Try to lookup any contacts based on the email from address
// If there is more than 1 contact with the same email address,
// an exception will be thrown and the catch statement will be called.
try {
Contact vCon = [Select Id, Name, Email
From Contact
Where Email = :email.fromAddress
Limit 1];

// Add a new Task to the contact record we just found above.
newTask.add(new Task(Description = myPlainText,

Priority = 'Normal',
Status = 'Inbound Email',
Subject = email.subject,
IsReminderSet = true,
ReminderDateTime = System.now()+1,
WhoId = vCon.Id));

// Insert the new Task and it will be created and appended to the contact record.
insert newTask;

System.debug('New Task Object: ' + newTask );

}
// If there is an exception with the query looking up
// the contact, this QueryException will be called.
// and the exception will be written to the Apex debug log.
catch (QueryException e) {
System.debug('Query Issue: ' + e);
}
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// Set the result to true. No need to send an email back to the user
// with an error message

result.success = true;

// Return the result for the Apex Email Service
return result;

}
}

InboundEmail Object

An InboundEmail object has the following fields.

DescriptionTypeName

A list of binary attachments received with the email, if any

Examples of binary attachments include image, audio,
application, and video files.

InboundEmail.BinaryAttachment[]binaryAttachments

A list of carbon copy (CC) addresses, if anyString[]ccAddresses

The email address that appears in the From fieldStringfromAddress

The name that appears in the From field, if anyStringfromName

A list of the RFC 2822 headers in the email, including:InboundEmail.Header[]headers

• Recieved from
• Custom headers
• Message-ID
• Date

The HTML version of the email, if specified by the senderStringhtmlBody

The plain text version of the email, if specified by the senderStringplainTextBody

The email address that appears in the reply-to header

If there is no reply-to header, this field is identical to the
fromAddress field.

StringreplyTo

The subject line of the email, if anyStringsubject

A list of text attachments received with the email, if any

The text attachments can be any of the following:

InboundEmail.TextAttachmenttextAttachments

• Attachments with a Multipurpose Internet Mail Extension
(MIME) type of text

• Attachments with a MIME type of
application/octet-stream and a filename that ends
with either a .vcf or .vcs extension. These are saved as
text/x-vcard and text/calendar MIME types,
respectively.

The email address that appears in the To fieldString[]toAddresses

52

Force.com Platform Apex Email Service



InboundEmail.Header Object

An InboundEmail object stores RFC 2822 email header information in an InboundEmail.Header object with the following
fields.

DescriptionTypeName

The name of the header parameter, such as "Date" or "Message-ID"Stringname

The value of the headerStringvalue

InboundEmail.BinaryAttachment Object

An InboundEmail object stores binary attachments in an InboundEmail.BinaryAttachment object.

Examples of binary attachments include image, audio, application, and video files.

An InboundEmail.BinaryAttachment object has the following fields.

DescriptionTypeName

The body of the attachmentBlobbody

The name of the attached fileStringfileName

The primary and sub MIME-typeStringmimeTypeSubType

InboundEmail.TextAttachment Object

An InboundEmail object stores text attachments in an InboundEmail.TextAttachment object.

The text attachments can be any of the following:

• Attachments with a Multipurpose Internet Mail Extension (MIME) type of text
• Attachments with a MIME type of application/octet-stream and a filename that ends with either a .vcf or .vcs

extension. These are saved as text/x-vcard and text/calendar MIME types, respectively.

An InboundEmail.TextAttachment object has the following fields.

DescriptionTypeName

The body of the attachmentStringbody

The original character set of the body field.The body is re-encoded as UTF-8
as input to the Apex method

Stringcharset

The name of the attached fileStringfileName

The primary and sub MIME-typeStringmimeTypeSubType

InboundEmailResult Object

The InboundEmailResult object is used to return the result of the email service. If this object is null, the result is assumed to
be successful.

The InboundEmailResult object has the following fields.
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DescriptionTypeName

A value that indicates whether the email was successfully processed.

If false, Salesforce rejects the inbound email and sends a reply email to the
original sender containing the message specified in the Message field.

Booleansuccess

A message that Salesforce returns in the body of a reply email if the Success
field is false.

For example, this message could inform the sender that the request could
not be processed and provide an explanation.

Stringmessage

If the InboundEmailResult object is null or the Success field is true, no
message is returned to the sender.

Force.com Web Services API 11.0
Available in: Enterprise, Unlimited, and Developer Editions

The Force.com Web Services API and related toolkits have been improved for Winter '08:

• Developers of AppExchange packages can specify whether or not to restrict the API access of components in the package
for greater security. Installers of AppExchange packages can view the API access given to components of a package they
are installing, and after installation can modify that access.

• In SOSL you can now set the LIMIT clause on individual objects. Setting individual object limits allows you to prevent
results from a single object using up the maximum query limit before other objects are returned.

• In SOSL you can now search solutions, products, and documents with other objects in a single query. Prior to this release
you could only search those objects separately.

• The sendEmail call includes the following new arguments:

• documentAttachments: An array listing the ID of each Document you want to attach to the email. You can attach
multiple documents as long as the total size of all attachments does not exceed 10 MB. (For single email messages
only.)

• fileAttachments: An array listing the filenames of the binary and text files you want to attach to the email. You
can attach multiple files as long as the total size of all attachments does not exceed 10 MB. (For single email messages
only.)

• senderDisplayName: The name that appears on the From line of the email. (For single and mass email messages.)

For complete details about Force.com Web Services API 11.0 enhancements, visit the detailed "API 11.0 Release Notes" on
the Apex Developer Network at wiki.apexdevnet.com/index.php/Apex_Wiki.

Additional Force.com Platform Enhancements

AppExchange

Based on your feedback, the AppExchange simplifies the process of developing your AppExchange apps in iterations before
publishing them.To develop your app in cycles and publish when you are finished, we have moved some steps in the publishing
process to the AppExchange directory. For example, you still create a package and upload it from within Salesforce. After the
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upload is finished, you will receive a link that you can share privately with installers. To create a test drive, choose a License
Management Organization, or register your upload, go to www.salesforce.com/appexchange/.

Email Relaying Available in Professional Edition

The email relaying feature introduced in Winter '07 for Enterprise, Unlimited, and Developer Edition organizations is now
available in Professional Edition as well. For more information on email relaying, see "Setting Up Email Relaying" in the
Salesforce online help.

Email Signature from Salesforce.com Removed

In previous releases, a salesforce.com email signature was automatically included in all email sent by customers from within
Salesforce. In Winter '08, this email signature is no longer included unless the email is sent from a trial organization or
Developer Edition.

Expanded Debugging Capabilities

The System Log has been expanded to include debugging info about the following features:

• Validation rules
• Workflow rules
• Assignment rules
• Auto-response rules
• Escalation rules
• Approval processes

For more information, see "Using the System Log Console" in the Salesforce online help.

Salesforce Mobile for BlackBerry: Related Items Search

BlackBerry users can now quickly search for a record's related items using an option on the menu. To retrieve related items:

1. Open a record, then open the menu and select a related list.
2. If the related list is empty, open the menu and select Get Related Items.

The mobile application retrieves any related records from Salesforce and displays the search results on the appropriate tab.
For example, if you initiate the search from an account's related contacts list, the results display on the Contacts tab.

3. To download a related item to your device, simply open the item. From the Search Results view, highlight the item and
press ENTER or select Open from menu.

4. Press the physical BlackBerry back button to return to the search results and download additional related items.

The mobile application cannot automatically download all the related items because a large amount of records could force
the device to exceed the total data limit set by your Salesforce administrator.

Formula Enhancements

Related Object Fields in Formulas
When working with formulas, you may want to reference merge fields for related records. For example,
you may want to build an opportunity validation rule that uses the value of the AnnualRevenue merge
field from the account related to the opportunity. Merge fields for related objects are now available when
you use formulas for approvals and rules such as:

• Approval process entry criteria ( Jump Start Wizard and Standard Setup Wizard)
• Approval step criteria
• Case and lead assignment rules
• Case and lead auto-response rules
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• Case escalation rules
• Validation rules
• Workflow rules
• Workflow field updates

Note:

• Merge fields are available from objects related through a lookup or master-detail relationship.
However, the merge fields for objects related to the related objects are not available. For
example, you can reference an opportunity merge field from an opportunity product formula
but no account merge fields. In addition, merge fields are not available through a self
relationship, an object that has a lookup relationship with itself.

• Custom formula fields for an object can still only reference fields for that object.
• Fields referenced in formulas cannot be deleted. Remove the field from the formula before

deleting it.
• You cannot reference merge fields for objects related to activities. For example, merge fields

for contacts and accounts are not available from task and event formulas.
• You cannot reference record owner merge fields for any object. For example, the opportunity

owner's role merge field is not available from opportunity-related formulas.

Functions Added - LPAD, RPAD, LOWER, UPPER
The following new text functions are available for use everywhere formulas are available:

• LPAD: Inserts spaces or characters you specify to the left-side of a text string.
• RPAD: Inserts blank spaces or characters that you specify to the right-side of a text string.
• LOWER: Converts all letters in the specified text string to lowercase. Any characters that are not

letters are unaffected by this function.
• UPPER: Converts all letters in the specified text string to uppercase. Any characters that are not letters

are unaffected by this function.

Login IP Range Restrictions

You can now restrict the login IP range for Professional Edition, Group Edition, and Personal Edition via Setup ➤ Security
Controls ➤ Session Settings. Prior to this release, only those Editions that supported user profiles allowed this restriction.
For more information, see "Setting Login Restrictions" in the Salesforce online help.

Product Name Changes

The Salesforce client applications have new product names:

• Outlook Edition is now Force.com Connect for Outlook
• Lotus Notes Edition is now Force.com Connect for Lotus Notes
• Office Edition is now Force.com Connect for Office
• Offline Edition is now Force.com Connect Offline

Restricted Login User

The number of restricted login users who have logged in during the current month is now available in the Company Information
page. For more information, see "Company Information Fields" in the Salesforce online help.

Roll-Up Summary Fields Expanded to Opportunities

The custom field type introduced in the Summer ‘07 release, roll-up summary field, has been extended to include support for
a standard relationship: opportunity to opportunity products.This provides easier access to aggregated opportunity information
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directly from an opportunity record without running a report. All existing roll-up summary field behavior remains the same.
For information on roll-up summary field behavior, see "About Roll-Up Summary Fields" in the Salesforce online help.

Search Settings Page

You can now modify settings related to Search by clicking Setup ➤ Customize ➤ Search. This page includes the following
options:

Enable Object Drop-Down List for Sidebar Search
The object drop-down list for sidebar search allows you to limit users' sidebar searches by object. When
you select Enable Object Drop-Down List for Sidebar Search, a drop-down list appears in
the Search section. From this list users can select to search within a specific object or across all objects.

Enable "Limit to Items I Own" Sidebar Search Checkbox
The Limit to Items I Own checkbox allows your users to include only records for which they are the
record owner when entering search queries in the sidebar.

Note: The Limit to Items I Own checkbox that appears in Advanced Search is always
available to users, regardless of this setting.

Number of Search Results Displayed Per Object
The Number of Search Results Displayed Per Object area allows you to configure the number of items
that are returned for each object in the Search Results page. The current setting is listed next to each
object in parentheses. To make changes, select one or more objects, enter the new number of results per
page, and click Save. The new value must be between 5 and 50.

User Records: New Standard Manager Field

The new Manager lookup field on user records simplifies creating approval processes that route requests to managers. In
previous releases, administrators needed to create a custom field to store the name of the user's manager. Now, user records
have a standard Manager lookup field that establishes a hierarchical relationship between the user and the user's manager,
preventing you from selecting a user that directly or indirectly reports to itself.

The standard Manager lookup field appears as an option when you select the approver for approval requests in both the
standard and jump start approval process wizards. If your organization already has a custom Manager field, that field also
appears, but is denoted as a custom field. salesforce.com recommends changing the name of any existing custom Manager
fields.

Merge Fields: Contact ID on Users

The Contact ID field on users is now available as a merge field. This enables organizations with a Customer Portal to create
s-controls that apply filters to portal users' contact IDs. For example, you could build an s-control that finds cases created by
portal users:

var caseQuery = "Select c.Id, c.LastModifiedDate, c.Priority, c.Status, c.Subject from Case
c Where c.ContactId='{!User.ContactId}'";

Workflow Rules and Approval Processes Visible with "View Setup and Configuration" Permission

Users with the "View Setup and Configuration" permission now have read-only access to workflow rule and approval process
configurations. In previous releases, only users with the "Customize Application" permission could view workflow rule and
approval process configurations.
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Workflow Rules for Mass Actions on Cases

Now, workflow rules are triggered when users select multiple cases from a list view and click Close, Change Owner, or Change
Status.

Specify the Sending Address on Email

If the email address in your email settings is different from the email address on your user record, you can now specify the
sending address on email from the From drop-down list. To alter email settings that apply to all outbound emails you send
from within Salesforce, click Setup ➤ Email ➤ My Email Settings.

Zero-Admin Mobile Deployment

In Winter '08, users can easily access their Salesforce data from a mobile device. A default mobile configuration is now provided
for Professional, Enterprise, and Unlimited Edition organizations. This allows users with an assigned mobile license to install
and activate Salesforce on their mobile device without any administrator assistance. Users who register a device with the default
mobile configuration can search for and download native object records to which they have access in Salesforce. To install the
mobile client application:

1. Verify that your device can support the mobile client application. See "Salesforce Mobile Supported Devices" in the
Salesforce online help.

2. Open the web browser on your mobile device and navigate to http://mobile.salesforce.com/setup to display the
Web page for the Salesforce Mobile installer.

3. Select the Click here to download the installer link and follow the instructions to download the latest version of Salesforce
Mobile to your device.

4. After the application downloads, open Salesforce Mobile.

• On a BlackBerry smartphone, click the Salesforce Mobile icon on the home page of your device or in your Applications
folder.

• On a Windows Mobile 5 Pocket PC, tap Start ➤ Programs, and then tap the Salesforce Mobile icon.
• On a Palm Treo, tap the InstallAXM icon on the device home page.

5. Accept the license agreement, and then enter your Salesforce username and password on the activation page. Select Activate
to register your mobile device with Salesforce.

6. When the login page appears, enter your password to begin working with yourSalesforce data wirelessly.

The default configuration does not automatically deliver any records to your device. Search for the records you want to
access with Salesforce Mobile. Contact your administrator to be added to a configuration that better suits your mobile
requirements.

Note:  Administrators cannot view or edit the default configuration. To prevent users from activating Salesforce on
their mobile devices before you are ready to deploy mobile in your organization, remove the mobile license from your
user accounts by editing the user records and deselecting the Mobile User checkbox. For more information, see "User
Fields" in the Salesforce online help.
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